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1. Getting Started

Installing COZOIL for Windows

COZOIL for Windows requires an IBM-compatible 586 or better PC, with 16 MB RAM, 30 MB free
disk space on the hard drive, a VGA color monitor, and Microsoft-compatible mouse, running
Windows 95.

To install:

1. Insert the installation CD-ROM.

2. Choose Run from the Start menu, and type d:setup in the Windows dialog box.

3. Follow the installation instructions on the screen.

4. When installation is complete, you will have a new program group labeled COZOIL

for Windows, with an icon for the COZOIL model system. Close this COZOIL for
Windows program group, and use the Reboot facility before running the
program.

To remove COZOIL from a Windows 95 platform:

1. Delete the entire COZOIL directory.

2. Remove the COZOIL program group.

About This Guide

This manual covers the following topics:

Installing COZOIL (Chapter 1)

An overview of COZOIL and its components (Chapter 2)

How to specify the environmental data sets required by the models (Chapter 3)
Running the spill model and displaying model results (chapter 4)

COZOIL auxiliary tools (chapter 5)

The COZOIL database (chapter 6)
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2. The Basics

About COZOIL

COZOIL is an oil spill model system used to predict the movement and fate of oil spilled in the
marine environment.

The COZOIL model system is comprised of several integrated components. The spill model
itself predicts the movement of oil on the water surface and the distribution of oil in the
environment (evaporated, in the water column, on the shoreline). For these calculations the spill
model relies on environmental data such as wind and currents, physical data such as the
proximity of shorelines, and chemical data that defines the type of oil. Each of these types of
data can be input and edited using the appropriate COZOIL component.

Although land and water is represented by polygons on the screen, the model actually uses a
gridded representation of this land and water boundary to determine:

Whether oil is on land or water

What is the shoreline type of the land grid cell?

What is the depth of the water cell?

The grid uses the COZOIL shoreline database to determine the shore type. To display these
shore segments, check the Display Shore Types menu on under the Data menu.

Geographic Location

The COZOIL application is specific to a particular geographic location. All data, spill scenarios,
and model output are stored within this location. The location consists of an area defined by its
outermost longitude/latitude coordinates. The location is given a name and contains a base map
depicting land and water. The name of the active location is displayed at the top of the map
screen.

COZOIL has three locations. To move
between locations, select Geographic
Location from the File menu. The
available locations will be listed. Click on
the desired location to make it active,

j| and then click on OK.

1] 4 Cancel |

Geographic Locations |I: [AWASA-1LSYS 3]

ARCTIC = kN
[~ cozoil

G0A

3 arctic
=1 bering
1 goa

The Spill Scenario
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Spill Scenarios are the means of organizing model data and parameters into unique collections.
A spill scenario in COZOIL is a collection of information which defines a model simulation. This
information includes a definition of the spill and the environmental data files used in the
simulation, saved under a unique scenario name. Typically a scenario specifies the land-water
grid, wind file and currents file used in the scenario; and the particulars of the spill itself (date,
location, oil type and amount released). Any of the data files which comprise a scenario may
belong to a single scenario, or multiple scenarios.

Land-Water Current wind Spill Information
Grid Data Data Spill Location
i i i Spill Amount
i i etc. .
SCENARIO

Before a model simulation, a scenario is only the set of forms inputs defining the input data.
After the execution of a model simulation, a scenario also has model output associated, which
may be displayed. Thus the term “scenario” is used to describe both the inputs and the outputs
of a model simulation.

In COZOIL there is always one active scenario. The active scenario name is displayed on the
toolbar, and the components of the scenario can be viewed in the map window.

There are several options available under the File menu for handling scenarios.
New Scenario is used to specify a new spill scenario. For this option, specify the scenario
name, and select the land-water and currents grids. Spill simulation parameters will be set
under the Model/Run Model menu.
Open Scenario is used to open a previously defined scenario and the results of the spill
simulation. The scenario selected becomes the active scenario. Its name is displayed on

the toolbar and the simulation output can be displayed in the map window.

Save Scenario is used to save the active scenario. If any editing has been performed on
the currents or land-water grid.

Save Scenario As is used to save the active scenario under a different name.

Edit Scenario is used to change the land-water and currents grids associated with the
active scenario. Changes made using Edit Scenario are automatically saved.
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m. Scenario Description The RESET button is availalble when a scenario is
being opened and a model simulation has been run
previously for this scenario. It will reset all of the
scenario parameters back to the state that was used
when the model simulation was run. This is useful if, for
instance, you edit the scenario and change the active

1] .4 Cancel

5cenariu|UHTITLE1 j| Hesetl

" Land Water Grid grid or edit some parameters without running the model.
| UNTITLED. FLT j| The reset button will then set the scenario information
back to exactly the parameters that were used to
" Hydrodynamic Data produce the model simulations.
|[TEST2 DIR =

The COZOIL Screen and Toolbar

The standard COZOIL screen consists of three major sections.
At the top is the standard menu bar:
Below the menu bar is the COZOIL toolbar. The toolbar contains buttons for various GIS and

map functions, and displays the name of the active spill scenario. The toolbar includes
buttons to control the display of the active scenario.

I (@ = EE ] | unmimier [« ] o] m] »][4/30/97 10:00:00 aM =]

Or

| &[G =B | STOCTEST = [ [impact Probabilty =]

Keys which are not active are “grayed out”. The toolbar options are described briefly below.

Map Buttons

To interrogate GIS objects.

To create a zoom window.

To zoom out to the previous zoom level.
To add/edit current vectors.

To edit land-water grid cells.

- I ol RO

To measure distances and areas.
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Oil Spill Animation Buttons

Rewinds the spill simulation to the start.

[ Displays the spill simulation in reverse.
E Displays the spill simulation one timestep at a time.
= Stops the display of the spill simulation.

[ Displays the spill simulation.

Displays the time in the simulation being shown. Click on this

|379/96 08:00:00 AM | #] : :
box to select a particular time.

R EACOZOILALOC_DATAMARCTIC

151 48 151 36 151 24 151 12

f0 336

& BARRODWA HSK ES
Maszz On Shore
Metric Tonnes

o-»
1-»
2>
3>
4>
5-»
G -»
i-»
8->
9>

70 28.8

=D SR ] | [ | ] S ] P [ =

70 24

2-4



Setting the Map View: Zoom Functions

Several Zoom options are available to change the scale of the Zoom

map display. Using these options the scale of the map can be Create Zoom Window Ctrl+W

increased or decreased, and the center of the map display can Zoom In Previous  Ctrl+]

be shifted. All these options are available under the Zoom menu. | Z°°m Qut Previous  Ctr+0
UnZoom All Ctrl+U
Pan Point to Point

To zoom in on an area of the map display:

1.

3.

4,

Select Create Zoom Window from the Zoom menu - OR - click on the Create Zoom
Window icon on the COZOIL toolbar.

Move the mouse cross-hair to one corner of the area to zoom into.
Hold down the mouse button and drag a box around the area to zoom into.

Release the mouse button, and the new zoom window will be created.

To return to a previous zoom window at a larger scale:

1.

2.

Select Zoom In Previous from the Zoom menu.

Each time you select Zoom In Previous, the zoom window created at a larger scale
than the current window will be displayed.

To return to a previous zoom window at a smaller scale:

1.

Select Zoom Out Previous from the Zoom menu - OR - click on the Zoom Out icon on
the COZOIL toolbar.

Each time you select Zoom Out Previous or click the Zoom Out icon, the zoom window
created at a smaller scale than the current window will be displayed.

To return to the original map scale:

1.

Select Unzoom All from the Zoom menu.

To re-orient the zoom window:

1.

2.

Select Pan Point to Point from the Zoom menu.

Click the mouse cross-hair on the map to set a reference point to move. Then move the
cross-hair to a new point on the screen where you want the previous point to be
displayed, and click. For example, if an island appears at the lower left of the map
display and you want to re-orient the display so the island is in the center, click on the
island, move the cross-hair to the center of the display and click again. The window will
be redrawn at the same scale with the island in the center.
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Customizing the Map Display

m. Dizplay Settings

Cancel |

Land Color I
Water Color [
Land Outhne Color
Lon/Lat Grid Color
Current Yector Color

Uzer Defined Yector Color
Dizplay Lon Lat Gnd
Display Distance Scale
Degree Representation
Yector Unitg

r Map Projection
(C1¥Y Cartesian
(® Mercator

(DD MM MM
|knots

Several options are available to adjust the
COZOIL map display. These options
include the colors and measurement units
used, and the map projection.

Most of the map settings that can be
changed are accessed through the
Display Settings option of the File menu.
This option brings up a form to:

select the colors used for land, water,
current vectors, and the longitude/latitude
grid. To select colors, click on the color
box to bring up a color menu.

Specify whether a longitude/latitude
grid is shown on the map. Toggle the field
between Yes and No.

Specify the units longitude and latitude

are presented in. Toggle the field between decimal degrees (DD.DD), degrees and decimal
minutes (DD MM.MM), and degrees-minutes-seconds (DD MM SS).

Specify the units current vectors are presented in. Toggle the field between mm/s, cm/s,

m/s, and knots.

Specify whether a distance scale is displayed on the map. Toggle the field between Yes and

No.

Specify whether to use No Projection or a Mercator Projection for the map.

Measuring Distances & Areas

To get the distance between two points, select the Distance Measure icon on the toolbar. Click
on the point from which to measure distance. This sets one end of the measurement line. As
you move the cursor around, the distance between the set point and the cursor’s position is
given at the lower left of the map. Clicking again with the left button will start another
measurement line segment. The total cumulative distance of all the line segments is displayed
on the status bar. Click with the right mouse button to close the polygon and get the area of the
polygon. Hit escape to exit the distance measurement mode.
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3. Specifying Environmental Data

Overview of Required Data

In this chapter the steps required to create the environmental data files used by the spill models
in COZOIL are described. Subsequent chapters present the individual models and describe how
to specify the scenario, run the models with the defined inputs, and display the results of these
model simulations.

The spill models require several types of input data.

Land-Water Current Wind Spill Information
Grid

Data Data Spill Location

| | Spill Amount

SCENARIO

See the appropriate section later in this chapter for complete information on how to specify each
type of data.

1.

A land-water grid. The land-water grid covers all or some part of the base map in the
active location. The grid should cover the spill site and the surrounding area of interest
(oil which moves outside the grid is not tracked). The land-water grid is used by the
models to determine which areas are land and which are water and to determine what
type of shoreline (ie. Sandy beach, Rocky shore, etc.) is along a coastline.

Wind time series. The wind time series provides the model with wind data measured
and/or forecast in the vicinity of the spill. The wind data consists of wind speed and
direction for a period covering the spill simulation.

A current field. Current data is provided with COZOIL and is based on the the COZOIL
database values. See the COZOIL Database chapter for more details.

The oil characteristics. COZOIL contains a library defining the characteristics of
several standard oil types. If desired, additional oils can be added to this database, or the
characteristics of the existing oils can be changed.

The spill scenario. The spill scenario contains the data that uniquely describe the
inputs to a particular simulation to be run. It includes the spill location, spill date/time,
type of oil, amount spilled and length of release, and specifies the land-water grid, wind
data, and currents used in the simulation. Spill scenarios are saved with a user-defined
name and the model results are given the same name (with a different extension).
Defining the spill scenario is described in Chapter 4.
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Land-Water Grid

In order to run a spill simulation, you must have a land-water grid to define what is land, what is
water, and what are the characteristics of the shoreline. The grid is a square mesh of individual
cells covering the area of interest. Each cell in the land-water grid is classified as either land,
water, or coastal. Each coastal cell has a code that indicates what shoreline type is dominant in
the grid cell. Each water cell has a value that indicates the depth of the water in that cell.

Each cell is the same size (in degrees), although they may not appear that way on the screen
based on the latitude and the map projection.

The maximum grid size is 250 by 250 cells.

Displaying a Land-Water Grid

 Gnd GRID1 Currents UNTITLED
[ |Cells ‘ r Tidal  :M2  |#]

The name of the selected land-water grid is displayed in the data tool bar (Use Edit Scenario in
the File menu to change the selected land-water grid). Select Cells to display the grid cells and
check the display box to the left on. —Grid GRID1 —

Creating a Land-Water Grid

The land-water grid is created by the following sequence of steps:

1. Select Create Grid from the Data menu. w New Grid
2. While holding down the left mouse button, 0K C
. ancel
drag a box on the map defining the area to be

covered by the grid.

Grid File Hame IUntitIed

3. Enter a name for the grid file and the number B .
Gnd Dimensions

of grid cells in the X (east-west) and Y (north- ) o
south) directions. There can be a maximum Cells in X-Direction [ 100 E

of 250 grid cells in each direction; the Cellz in Y-Direction | 48 E

minimum is 1 cell.
Cell Size [degreesz] I 0.00513

4. Click OK to save the grid.

A land-water grid will automatically be created for the area selected. When the process is
complete, you may automatically include this new grid as part of your Active Scenario.
See the previous section, Displaying a Land Water Grid or how the display this new grid.

Examine your newly created grid closely to be sure the delineation of land and water is
appropriate for your model simulation. As an example, make certain the cell size is small
enough to resolve narrow inlets as water cells and that small islands are flagged as land. If the
grid is not appropriate, remake it using a larger or smaller cell size or edit the grid to change the
classification of individual cells.

Shoreline types will also be assigned to each coastal cell from the COZOIL database of shore
types. An interpolation method is used to determine the closest shoreline segment to each
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coastal cell and the type of that segment is assigned to the cell. To display these actual shore
segments, check the Display Shore Types menu on under the Data menu.
Depth data is also interpolated from the COZOIL database.

Editing a Land-Water Grid

Any existing grid can be edited to change:
the depth of water cells
the shore type of coastal cells.

~ Grnd GRID1 | I . .
: - From the data tool bar, select the cell classification that you wish to view.

You may choose:
Cells
Depths

Editing cannot be used to increase or decrease the area covered by the grid or the number of
grid cells. To change either of these parameters requires creating a new grid.

With the desired grid displayed:
& EACOZDILALOC_DATAVARCTIC

MList| 30,16 7| o] ]
Shore Type | SAND BEACH =l ExPOSED ROCKY SHORE | [
_| [Dil on Shore (Metric Tonnes) | GRAVEL/COBELE /BOULDEH L
— Cozoil Database Information - |PEAT”UNDHA SCARP
————— I = SAND BEACH
Beachit | 31.004 |
Shers Tyie Coda [+ MIXED saND/GRAVEL BEAC [N
Length (m] 826 N [TIDAL FLAT
Azimuth | 144 T METMNDHHAHSH
Distance to 20m isobath ] I |LAEDDN -
Distance to 10m isobath [} _ IRIVER CHANNEL 0
Distance to 1m izobath [_?l]l1_
Distance to 33cm isobath | 2305
Backshore Length [m] 1] §
il Backshore Slope !E i T
Backshore Angle | 1} Il
Foreshore Length [m] | 0 I
Foreshore Slope | O G
Foreshore Angle [0 -
55
I [
7o 1 25 krn
]
1.3 Hm
L] O
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1. Select Edit Land-Water Grid Cell from the Data menu, or click on the Edit Grid Cell
icon on the toolbar.

2. It is often helpful to zoom in on the area being edited.

3. Click in any cell of the grid. Hold down the CTRL key to select multiple grid cells.

4. Use the cell edit window to edit the characteristics of the cell.
Click Apply to apply the new type to the cell(s). If more than one cell is selected, then
Apply will alter the characteristics of all the selected cells.

5. If a water cell is selected, then you may also edit the depth of the cell.

6. Once all editing is complete, select Save Scenario under the File menu. You will be
prompted to save your changes to the grid.

Currents

Current data is required to run a spill simulation; the model will not run without a current field.
Current data is provided and is based on the data in the COZOIL database. However, the
COZOIL database lacked information such as phase (ie. when is high tide) and direction. So,
current fields were generated based on the current speed stored at each shore segment. A
vector was generated and assumed to be parallel to the shoreline. This data has no phase
information and has artificial direction information. Tidal period was also obtained from the
COZOIL database and the system will suggest which tidal period to use based on the location of
the spill site and the tidal period in that region.

A current sketching tool is provided so that these currents may be edited manually.

These currents can then be spread over the area of interest to create a rough estimate of the
current field. The current painting capability is designed as a temporary measure to
pictorially represent general current features. It does not replace hydrodynamic model
output, and can lead to the description of flow patterns which are clearly not mass
conserving.

The name of the current file that is loaded with the active scenario is shown on the data tool bar.

 Grd GRID1 Currents UNTITLED
[ |cels ‘ r Tidal  :M2 %]

Types of Currents

The COZOIL currents have two components:
M2 tidal currents (two high tides a day, period approximately 12.4 hours)
K1 tidal currents (one high tide a day, period approximately 23.9 hours)

Tidal currents are time-varying currents caused by the ebb and flood of the tide. The vectors that
are entered are assumed to be max flood stage. By setting the time of high tide in the spill form,
the model will initialize at different times in the tidal cycle. However, the COZOIL database does
not have current direction so direction of high tide is not known. So, setting the high tide time will
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affect the point in the tidal cycle that the simulation begins, but it is artificial as we do not know
the true direction of maximum flood (only assumed) and no phase information is available.

Viewing Current Data

The current vectors in any currents file can be displayed. To display a current field it must be
specified as part of the active scenario. Use Edit Scenario in the File menu to change the
selected current file for the active scenario.

Currentz UNTITLED

| ml o] »] Hous: 1035053 |[Tidal M2 [3]

‘ Current Grid

Display Vectors Component Display Current Scale

To specify the current component to be viewed, select from the list of current types. Check
the display box to the very left on to view the current vectors on the map. Use the Play
buttons to animate/step the current vectors in time. The time label will give the time in hours
into the animation.

To display the current grid, check the grid icon to the right of the tool bar on.

Click the Scale icon to bring up the Scale Window

=| il RIAVEREEIPE This window may be used to scale the presentation of
- 4 | the current vectors on the map.
WF || It does not change the actual current values.
| 050  |knots

To scale the size of the displayed current vectors, click on the up/down arrows at the bottom of
the window to increase/decrease the vector size. The vector to the left of the up/down arrows
shows the size that a current vector will be displayed on the map. The velocity of this vector is
shown at the bottom right of the window. Its units depend on the Vector Units setting under the
Display Settings option of the File menu. Once the representative arrow is of the desired size,
click on Apply to change the display scale of the currents on the base map. This does not
change the value of the data, only its representation.

Editing a Currents Grid

Any existing grid can be edited to change the designation of individual cells as land or water.
Editing cannot be used to increase or decrease the area covered by the grid or the number of
grid cells. To change either of these parameters requires creating a new grid.

To edit a currents grid it must be specified as part of the active scenario and it must be
displayed.

With the desired grid displayed:
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Select Edit Current Grid Cell from the Data menu.

Data
Create Grid »
Edit Land-Water Grid Cell
Current Yector [ 2

Edit Current Grid Cell
EnterfEdit Winds
0il DataBase

Click in any cell of the grid to toggle its designation from water to land or from land to
water. Continue to toggle grid cells until the grid has been adjusted to your satisfaction.

Once all editing is complete, select Save Scenario under the File menu. You will be
prompted to save your changes to the grid.

Adding/Editing Current Vectors

Currents are entered into the currents grid as vectors, which are displayed as arrows whose
length represents the speed of the current. The vectors point in the direction the current is
moving.

To add current vectors to a currents grid follow the steps below:

1.

2.

Select the type of current to be added (M2 or K1).

It is often helpful to zoom in on the currents grid or some portion of the grid before
entering current.

Select Current Vector from the Data menu, then select Add Current Vector; or click
on the Add Current Vector icon on the toolbar.

Tidal currents are specified at maximum flood. The tide is assumed to be rectilinear, i.e.,
ebb tide is the opposite of flood tide.

Position the cross-hair cursor in any grid cell to anchor the current vector in that cell.
Depress the mouse button and drag the cursor away from the anchor point to draw a
vector defining the current speed and direction. The speed and direction (in degrees
clockwise from North) of the vector are displayed at the bottom left of the map window.
Release the mouse button to set the end of the vector when the desired speed and
direction are displayed.

Note that as the mouse is moved over current grid cells, the value for the current
vector in that cell will be displayed in the status section at the bottom of the
screen.
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6. To edit an existing vector, click on the existing vector position and draw in a new vector.
This will replace the previous vector. Note that as you move the mouse over grid cells
that contain vectors, the exact speed and direction of each vector is displayed in the
status bar on the bottom of the screen.

A right-click on any current grid cell will allow entry of the current vector values
exactly. This allows the user to enter exact values for specific cells.

7. Repeat steps 5 & 6 to enter as much data as you have available. Optimally the data will
establish the basic flow pattern.

When done, save your changes. Select Save Scenario from the File menu to save changes.
If the grid is only partially filled with currents and not suitable for use by the spill model, the final

step is to fill the empty grid cells based on the vectors just entered. See Filling the Current
Field section.

Filling the Current Field

Two utilities are provided to fill the current field with the user-input current vectors. The Spread
option interpolates/extrapolates your input currents to empty cells; the Smooth option spatially
smooths the differences between the current vectors. Additionally, the Smooth operation
constrains the flow so that no flow occurs across a closed boundary (i.e., land). Thus, after
smoothing, a current grid cell with two closed boundaries will not have any associated current.

The Spread option should always be selected to fill empty cells. It should be done first. The
Smooth option is generally done once to create a more uniform current field.

It is often helpful to display your input currents and the Spread/Smooth currents in different
colors. Use Display Options in the File menu to change the vector colors.

To Spread current vectors over a grid:
1. Select Current Vector from the Data menu, then select Spread Vectors.

2. The user-defined vectors will be used to interpolate/extrapolate current vectors into
empty grid cells.

To Smooth current vectors in a grid:

1. Select Current Vector from the Data menu, then select Smooth Vectors.

2. To smooth only the interpolated/extrapolated vectors and leave the user-defined vectors
unchanged, select Only Interpolated Vectors. To smooth all the current vectors in the
grid, select All Vectors.

When done, select Save Scenario from the File menu. You will be prompted to save the

changes. The completed grid contains background and/or tidal currents saved in a file with a
DIR extension. This file can now be used in a spill simulation.
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Currents Display Options

To change the units speed. Select Display Settings from the File menu. Click on
the units box to the right of Vector Units to toggle through the options available.

To change the color of your input current vectors. Select Display Settings from the
File menu. Click on the color box to the right of User Defined Vector Color and select
the desired color.

Scaling Current Data

Once a current field has been entered, the magnitude of all the current vectors in the field can be
increased or decreased by a constant scale factor.

To scale a current field it must be specified as part of the active scenario and the current
component to be scaled must be selected.

From the Data menu select Current Vector and then =] Vector Scaling

Scale Vectors. In the Vector Scaling window, enter the — |
H . ‘0OK: Cancel
scaling factor to be applied to all current vectors. For | [
example, a factor of 1.20 will increase the magnitude of
all current vectors in the selected current component by e L el
0 i ¥ 11.00
20%. To decrease the magnitude of the vectors, enter a what amount?

number less than 1.0.

Winds

The wind data required for a model simulation consists of a series of wind speeds and directions
covering the time period being modeled. COZOIL contains a Wind Data Editor to facilitate the
task of entering wind data.

Alternatively, the user may select Climatological Wind to run the model with and a wind time
series will be generated automatically based on the average wind speed for the month of the spill
in that region. The system will find the COZOIL shore segment nearest to the spill site to get the
average wind speed and standard deviation and use a Poisson distribution to create a wind time
series.

The Wind Data Editor

The Wind Data Editor contains tools to input and display wind data. A “dart board” is used to
input wind speed and direction with a simple “point and click” technique. Alternately speed and
direction can be manually entered. A time increment setting is available so that wind data do not
need to be input at hourly intervals. To view the data in the wind file a listing of each wind speed
and direction entered is provided, and a stick plot showing the wind data is presented.
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= Wind Data Editor UNTITLED.WWNE
File

Speed Angle From |Speed:50 Angle:246 CDIR-WSW |

11722/9603AM 5 225 Sw [+ N
11/22/96 04 AM 5 207 SS5W B0
11/22/9605AM 5 192 S5W i
11/22/9606AM 10 188 5 30
1172279607 AM 10 195 SS5W 5
1172279608 AM 10 197 S5W il
11/22/96 09 AM 10 204 SS5W 5
11/22/96 10 AM 15 209 S5W 0
1172279611 AM 15 213 S5W 5
11/22/9612PM 15 219 SW 0

1172296 01 PH 15 224 5w
11/22/96 02 PH 15 224 5w

11/722/96 04 PH 15 180 S
11/22/96 05 P 20 158 SSE :I
11/22/96 06 P 20 158 SSE
1172296 07 P 25 135 SE
11/22/96 08 P 25 135 SE
11/22/96 09 P 25 135 SE
11/22/96 10 PH 25 135 SE 3

Add Record |

|
e d bt 32222228 I NANNN|[ EditRecod |
|

Delete Record

1142296 03 AM 11/22/96 09 PM 1 |& | Increment
¥ [ [Hourg]

The dart board is the quickest way to enter wind data. The rings of the dart board correspond to
different wind speeds (in knots), increasing in speed away from the center. The direction from
which the wind is blowing is indicated by the clockwise angle (0 to 360 degrees) around the rings
of the dart board. As you move the mouse around the dart board, the wind speed and direction
corresponding to the mouse’s position are displayed in the text box above the dart board.
Clicking the mouse on the dart board adds a wind record to the wind file.

The wind data you enter is assumed to follow the meteorological convention: the direction is the
direction FROM WHICH the wind is blowing. The stick plot which displays the wind data follows
the oceanographic convention: the direction is the direction TOWARD WHICH the wind is
blowing.

Entering Wind Data
The following steps describe the process of creating a new wind file.

1. Start the Wind Data Editor by selecting Enter/Edit Winds from the Data menu.
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Select New File from the Wind Data  [=] New Wind File
Editor's File menu. Enter a name for
the wind file and set the start date and (1]'4 ‘ Cancel
time for the new file. Clicking in the box

for the date/time entry brings up a
calendar from which the date and time | yz 4 File Name m
can be selected. The default
coordinates for the wind station will be Start Time 111721796 03:00:00 P

the center of the map. SO |
esCcripion

To use the calendar click on the Coordinates
desired year, month and day of month

’ . | DD.DD
on the calendar display. To select the 37.88447 | N %DD MM MM
current day’s date, click on the Today | 2401164  E C/DD MM 55
button located below the monthly CUk 0s

calendar. Use the up/down arrows to
the right of the hour and minute boxes at the bottom of the calendar to select the time the
wind record is to begin. Click on OK to save the selected date/time and return to the
New Wind File window.

Set the time Increment (in hours) at which data will be entered. At the lower right of the
Wind Data Editor window is the Increment box with up/down arrows to
increase/decrease the increment. The time increment is the duration that each wind
speed/direction entry will last. For example, a 6 means that each wind observation is
valid for the next six hours. At any point while entering wind data, the time increment can
be changed. Therefore you can enter known hourly wind data (Increment equals 1) for a
period of time.

Enter wind speed and direction records by
either clicking on the dart board, or selecting
the Add Record button. This will allow manual
entry of wind values

=| 11423{96 02 AM

Add I ‘ Cloze

To use the dart board, place the mouse on the Speed | 20 Knots
dart board at the desired wind speed and
direction, and click. Each click of the mouse
on the dart board generates one entry in the
time series. The wind data entry is added to ]
the table to the left of the dart board and to the O Degrees
stick plot graph at the lower left of the Wind
Data Editor window.

- 'Wind Direchion

(® Meteorological

(0 to 360)

When all data have been entered, select Save File from the File menu to save the file.
The table and the stick plot will clear.

Exit the Wind Data Editor by selecting Exit from the File menu.
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Editing Wind Data

The following steps describe the process of changing an existing wind file. Existing wind data
entries in the file can be changed and new wind records can be added to the end of the file.

1.

2.

Start the Wind Data Editor by selecting Enter/Edit Winds from the Data menu.

Select Open File from the Wind Data Editor=s File menu. Select the name of the wind
file to be edited. Click OK to continue.

To change existing wind data entries:

Scroll through the wind record listing to the date and time for which wind data will be
changed. Click on the data entry to be changed (it will be highlighted).

To use the dart board to change the wind speed and direction, place the mouse on the
dart board at the desired wind speed and direction, and click. The speed and direction
corresponding to the mouse=s position are shown in the text box below the dart board.

To change data by typing the speed and direction, double click on the entry to be edited
(or highlight the entry and select Edit Record).

To add more wind data to an existing wind record:
Scroll to the end of the wind record listing.
Add wind records by clicking on the dartboard or by using the Add Record button.

When all changes have been made, select Save File from the File menu to save the file.
The table and the stick plot will clear.

Exit the Wind Data Editor by selecting Exit from the File menu.

Importing Wind Data

A wind data file can be created in the ASW format (see Appendix) using a text editor and
imported into COZOIL for use in the spill models.

To import an ASW wind file:

1.

2.

3.

From the Data menu select Enter/Edit Winds.
From the File menu of the Wind Data Editor select Import ASW File.

Select the file to be imported.
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=| Qil Datahase

Th e OI I Datab ase oK Cancel New Oil

0Oil DataBase |§MEDIUM CRUDE OIL

COZOIL contains a library defining the characteristics of

several types of oil. The standard oils are: Oil Name IMEDIUM CRUDE OIL
gasoline Density (gm/cm=3) [0837
diesel Viscosity [cP) [#3.000
light crude oil Interfacial Tension (dyne/cm) | 30.000 |
medium crude oil Maximum Water Content (%) | 70.000 |
Prudhoe Bay crude Initial Boiling Point (K] [384200
heavy crude oil Gradient of Curve [49a210
Bunker C (fuel oil #6) Evaporation Constant A [Bo00

JP-4 (fuel Oll #1) Evaporation Constant B I 12.550

The parameters stored in the oil database affect the

spreading, evaporation, and mousse formation algorithms of the COZOIL fates routines during
spill simulations.

Any of the parameters can be changed. New oils may also be added to the database. Oil data
are stored by geographic location, so any changes made to the oil database are specific to the
oil database in the geographic location active when making the changes.

Oil Characteristics

The oil database contains a name and eight parameters identifying each oil. The oil parameters
are used by the spill models to characterize each oil's behavior. Each type of data in the oil
database is described below.

Oil Name - a unigue name up to 20 characters long to identify the oil.
Density - the density of the whole, unweathered oil (gm/cm?).
Viscosity - the dynamic viscosity of the oil at 25EC (cP).

Interfacial Tension - the oil-water interfacial tension (dyne/cm).

Maximum Water Content - the maximum water content of emulsified oil (%). Enter O if the oil
does not emulsify.

The final four parameters are used to define the evaporation characteristics of the oil. These

parameters are inputs for Mackay=s evaporative exposure approach used to model evaporation.

Initial Boiling Point and Gradient of Curve - Determine these values for the oil by
plotting the oil’s liquid (not vapor) temperature in degrees Kelvin versus the fraction of oil
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condensed (the modified distillation curve). If only the vapor temperature is available for
the distillation curve, a rough approximation of the liquid temperature can be obtained by
adding 30° C to each vapor temperature. Enter the initial boiling temperature (degrees K)
for the first parameter and the slope of the distillation curve for the second parameter.

Evaporation Constants A and B - These values are determined by plotting In(H) versus
Tg/T. The relationship between H and Tg is

In(H)=A-B* (Tg/T)
where
H= Henry:s Law constant

Tg = Boiling temperature (K)
T = Ambient temperature (K).

Values of A = 6.3 and B = 10.3 generally provide reasonable results for most oils.

Editing an Oil

The name and parameters defining any oil already in the database can be changed. The
parameters are described in the previous section Oil Characteristics.

To edit an oll:

1. Select Oil DataBase from the Data menu.

2. Click in the first field of the Oil Database window to display the list of available oils. Select
the oil to be edited.

3. Click on the field containing the property to be changed. Any of the parameters, including
the oil name, can be changed. Enter the desired value. TAB or click to move to a new
field.

4, Repeat step 3 to change all desired properties.

5. To save changes and exit the Oil Database window, either click OK at the top of the
window or press the ENTER key after entering data in a field. To exit without saving
changes, click on Cancel at the top of the window.

Adding an Oil

To add a new oil to the database you must specify the parameters defining the oil’s
characteristics. Default values are provided based on the previous oil listed. The oil parameters
are described in the section Oil Characteristics.

To add a new oil:
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Select Oil DataBase
from the Data menu.

Click on New Oil at the
top of the Oil Database
window. This will fill the
fields Oil Database and
Oil Name with the name
ANew Qil@ The other
fields will contain the
values for the oil which
was listed when New
Oil was selected.

Click in the Oil Name
field and replace the
name ANew Oil@with
the name of the new oil
to be entered. No check
is performed to verify
that this name is
different from other

names in the oil database. Therefore, unless you mean to have two oils with the same

=| 0il Database
‘ 0K ‘ Cancel New Oil
0il DataBase |New 0il |+]
Dil Name [New DIl
Density [gm/cm==3) | 0.837
Viscosity [cP) | 33.000
Interfacial Tenzion [dynefcm] I 30.000
Maximum ‘Water Content [%] | F0_000
Initial Boiling Point [K] | 384200
Gradient of Curve | 494.210
Evaporation Constant A | 8.000
Evaporation Constant B I 12.550

name, be certain to enter a unigue name.

Move to each of the fields containing the values to be changed. Enter the desired value
TAB or click to move to a new field.

Repeat step 4 to change all desired properties.

To save changes and exit the Oil Database window, either click OK at the top of the
window or press the ENTER key after entering data in a field. When you save the
changes, the name in the Oil Name field is added to the list of oils in the Oil Database.
To exit without saving changes, click on Cancel at the top of the window.
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4. Running the Oil Spill Model

The COZOIL trajectory and fates model tracks the surface movement of oil and determines
the oil’s distribution in various environmental compartments: water surface, atmosphere, water
column, and shoreline. The model has specific focus on the oil-shoreline interaction and
algorithms are included that combine oil information, shore type, wind speed/direction, and tidal
information to provide analysis on how the oil interacts with the shoreline.

Quick Start

There are a number of simple steps to running a new spill simulation.

1. From the File menu, select the New Scenario, type the scenario hame.

2. From the Model menu, select the spill site on the map.
3. From the Model menu, select the Run Model option.

4. Fillin all the appropriate values on the spill form tab windows (see Specifying the Input
Data section for more details). Be sure to select a land-water grid, current grid, and wind file.
See the Specifying Environmental Data chapter for information on how to create these
files.

5. Click the Run Model button and let the model run the simulation. The Simulation Complete
message box will let you know that the model is complete.

6. Use the tools on the top toolbar to view the results.

Specifying the Input Data

The input data required by the spill trajectory model includes a land-water grid, a wind time
series, a current field, and a spill scenario that describes the conditions of the spill. The first
three of these types of input and the steps involved in specifying the files are described in detail
in Chapter 3. Specifying the spill conditions is described below.

The spill scenario is the information that uniquely describes the conditions of the spill simulation.
Included in the spill scenario are such data as the spill location, amount and type of oil spilled,
environmental conditions, and various model parameters.

Two steps are involved to specify the spill scenario. The first locates the spill site, and the
second specifies the rest of the scenario information.

To set the spill location:

1. From the Model menu, choose Select Spill Site.
2. Position the mouse cursor on the map over the spill site. The coordinates of the cursor

are displayed in degrees at the lower right of the map window, and change as the cursor
is moved about the map. Click when the mouse is positioned on the site of the spill.
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To specify the spill scenario:

From the Model menu, choose Run Trajectory Model.

Set the scenario name at the top right of the window, or select an existing scenario to fill the form
with the values used for that scenario. Specify a new name if you don’t want to replace the
existing scenario with the new simulation.

The Trajectory Model window contains three tabs: one each to specify scenario information,
environmental data, and model parameters. Both the scenario information and environmental
data tabs must be filled out to completely specify the spill scenario. The model parameters tab
controls certain model variables for the simulation, but does not specify spill specific information.
The fields in each tab are described below.

Once the necessary input data has been specified and the spill scenario has been defined, the
model can be run. While still in the Trajectory Model window, click on the Run Model button at
the top of the Spill Information form.

A separate process with its own window will display a tabular output of the oil mass distribution
in the environment as the simulation proceeds. When the simulation is complete, view the
model output as described further in this chapter.

Scenario Information:

W Trajectory Model E2

Close | Run Trajectory Model Eeamerio [emes |test2h j|

Scenario Information T Ervironmental Data T Model Parameters
Description I description C'DD.DD
g DD MM MM
i 59 | 22.17956 i 154 | 2.86848 DD MM 55
Latitude I I /| Longitude I I Wt CUK 05

Spill Start Time |4!3l].a"9? 10:00:00 AM

Oil Spill Amount | 10000.0 Banels || [MEDIUM cRUDE OIL =]
Spill Duration I 0.0 Hours
Model Duration | 48.0 Hours Humber of Stochastic Huns IIE

Description - an optional description of the scenario.

Latitude, Longitude - the spill location. These coordinates correspond to the spill site selected
using the mouse, and can be adjusted here. To the right is the option to specify the latitude and
longitude in decimal degrees (DD.DD), degrees and decimal minutes (DD MM.MM), or degrees-
minutes-seconds (DD MM SS).
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Spill Start Time - the date and time the spill starts. Click in the field to bring up a calendar on
which to specify the date and time. To use the calendar click on the desired year, month and day
of month on the calendar display. To select the current day’s date, click on the Today button
located below the monthly calendar. Click on OK to save the selected date/time and return to the
Trajectory Model window.

Oil Spill Amount - is followed by three fields to specify the amount spilled, the units of the amount
spilled, and the type of oil spilled, respectively.

Spill Duration - the length of time (hours) that oil is being released at the spill site. An
instantaneous spill (all oil released at once) has a spill duration of 0.

Model Duration - the length of the spill simulation (hours), i.e. how long the model will make a
prediction for.

Number of Stochastic Runs — If this is specified as more than 1, the COZOIL will run in
stochastic mode and, based on randomizing climatological wind information, will produce a
probability table of where the oil will impact land.

Environmental Data

m. Cozoil Model
Close Run Cozoil Model Scenario Mame |harmw4 _:H
Scenarnio Infarmation T EEnvironmental D ata: r Model Parameters )
Grid File |BﬁHHDWE-F|—T _:" Air Temperaturei -19 Water Temperaturei -1 %E:Lsrg‘:heit
BARRBOW. WHE  04/30/1997 10 - 05/07/1997 23 i Wind Options

Wind File I

HES86.WHNE
TEST.WNE
UNTITLET.WHNE
UNTITLE2 WHE

0543171986 13 -
01/30/1997 10 -
081541997 10 -
0941551997 10 -

0973071986 16
027011997 10
08/161997 17
09171997 17

® Wind Time Seriez
" Climatological Wind
CiMarkoy Matrix

Curent File| ARCTIC.DIR = |6 |0 | High Tide Time [0-23)
- Components Tide Hange [m] I 0.20

@ M2 Period 124 hours

irI;reduminant Tidal Period iz 12.4 Hours
CIK1 Period 23.9 hours

Wave Senes File ‘ ;i‘ Uze Wave File [

Air Temperature/Water Temperature - average air/water temperature over the length of the
simulation. This is retrieved from the COZOIL database.

Grid File - specifies the land-water grid to be used in the simulation.

Wind File - the wind data file to be used in the simulation. The list includes the

names of all available wind files, and the beginning and ending times of each wind record.

To run the simulation with climatological wind, toggle the Use Climatological Wind option.

To run the simulation (stochastic only) with a markov matrix, toggle the Markov Matrix option.
Click the Wind File button to access the Wind Data Editor to edit or create wind files.
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Current File - specifies the currents to be used in the simulation. Next select the current
components (tidal and/or background) to be used in the simulation. The default value will
automatically be set by finding the tidal period for the region of the spill. The database is
searched to find the shoreline reach nearest to the spill and the period is used from that reach.

Remember that COZOIL tidal currents have vectors for maximum flood stage. The time of
high tide entered here allows the model to phase these currents for the oil spill calculations.
Time of high tide is the time when the water elevation is the maximum.

Tide range may manually be entered. The default value is retrieved from the COZOIL Database.
The database is searched to find the shoreline reach nearest to the spill and the range is used
from that reach.

Model Parameters:

w. Cozoil Model
Cloze Run Cozoil Model Scenario Hame |harmw4 _v_!|
Scenarnio Infarmation T Enwvirgnmental Data T Model Parameters ]
Model Time Step [min] I G0 - RCPWAYE Parameters
¥ Run RCPWAYE
Output Time Interval [min] I &0 ' Fun
Write RCP Dutput File to Dizk X
Horizontal Diffusion[m™=2/s) I 3.00 {Include Diffraction Effects X
Number of Spillets l 100 Entrainment Algorithm
Wwind Factor (%) [350 ® Mackay
CAudunzon
Wwind Angle [degrees] ! 0

Model Time Step - the time step for model calculations (minutes).

Output Time Interval - the time interval at which model calculations are saved (minutes). It
should be a multiple of the model time step.

Horizontal Diffusion - controls the random horizontal component of the oil's movement (m?/s).

Number of Particles - the number of individual spillets used to represent surface oil.

Wind Factor - the wind drift factor (%).

Wind Angle - the angle oil moves relative to the wind (degrees).

4-4



Spreading Coefficient - controls the rate of surface slick spreading (/sec).

Note: The animation sequence will be re-displayed to the currently selected output
time when the map is redrawn. To turn off the animation, click on the Rewind

button to set the simulation to the very beginning.

Mousse Coefficient - controls the rate of emulsification.

Minimum Thickness - controls the minimum thickness to which oil can spread (mm).

Run RCPWAVE — Run the model with/without wave calculations. (see technical manual)

Entrainment Algorithm — Select which entrainment algorithm to use. (see technical manual)

Viewing Trajectory Model Results

Once a model simulation is complete, the spill trajectory can be viewed at any time as an
animation sequence. The output from a model simulation is saved as part of a scenario. The
name of the active scenario is displayed on the toolbar.

If the scenario was run with the Number of Simulations greater than 1, the
model was run in stochastic mode and animations are not available.

Select the scenario to be displayed. The name of the active scenario is shown at the center of
the top toolbar. To select a different scenario for display, use Open Scenario under the File
menu to open an existing scenario. The five buttons to the right of the scenario name on the
toolbar control the display of the spill animation. Use the buttons on the toolbar to start, stop and
rewind the animation.

Rewind the animation to the start of the simulation.

Display the animation in reverse.

Step through the animation, one time step at a time.

Stop the animation sequence.

Run the animation sequence.

= Bl &

(379796 08:00-00 AM | #| The simulation date and time corresponding to the animated

trajectory display are given at the right side of the toolbar. As the spill
animation progresses, the date and time are updated accordingly. To display a particular time
'El'ing the simulation, select from list of available simulation times.

[

A
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m. Oil Spill Display Settings From the main menu, use the Oil spill

: Display Settings window to set the oil
| Cancel | spill colors and display options for
' trajectory animations.

“Model Dizplay Options

[¥X Display Surface Spillets

[X Display Swept Area

[X Display Dil on Shore Amounts
[ Displap Wind Yector

[¥ Display Spill Site

 izplay Colors
0il Surface Spillets
Oil Shore Hits
Surface Swept Area

Displaying the Oil Mass Balance

= Qil Spill Model YWeathering Information
Oil Spill Weathering/Fates
& —— A — —
Surface Water Column
HE - .- b4
Ashore Evaporated
B0 E e —
70 £ e M
= / |
60 £
50 +
R 40 £
30
20 £
10 £

5 1M 15 20 25 30 35 40 45
Time {hours)

The oil's distribution in the environment over the period of the simulation can be displayed
graphically. From the Model menu select Fates Calculations.

Fates Listing will create an ASCII file of the fates information.




Fates Graph will display a window with a graph showing the mass of oil on the water surface, in
the atmosphere (evaporated), in the water column (dispersed), and on the shoreline. The x-axis
of the graph is the time into the simulation; the y-axis is the oil mass %.

Double clicking, or right-clicking, on this graph brings up customization options for the graph
presentation, printing, and data export options.

This data is stored in a dBase file in the FATES directory under the location and may be
important to other applications such as Access or Excel for further analysis.

Oil-Shore Output provides a summary listing of the shoreline impacts.

Exporting Model Results to Other Applications

The trajectory model output file is written in a standard dBase file format for use by other
applications. This data is stored in a dBase file in the TRAJ directory under the location with a
filename of scenario.DBF. It may be used by other applications such as Access or Excel for
further analysis.

A listing of this file is available under the Trajectory Table option of the Model menu. The file
includes data for each spillet at every output interval. The data given in the file are:

Time — time into the simulation (hours).

DateTime — the calendar date (month/day/year) and hour (24-hour time).

ParticleID — an identifying number for the spillet. This number is not necessarily a unique
identifier because when spillets combine with other spillets, go totally ashore, or move
outside the model grid, their ID number can be re-used and the particle ID array is
compressed.

Longitude — the spillet longitude location (decimal degrees). A negative value is used to
denote west longitude.

Latitude — the spillet latitude location (decimal degrees). A negative value is used to
denote south latitude.

Oil Mass — spillet mass (metric tons).

Thickness — spillet thickness (meters).

Radius — spillet radius (meters).

Viscosity — spillet dynamic viscosity (centiPoise).

Status — a code indicating the status of the spillet (O = ashore, 1 = water surface, 2 =in
ice (not used), 3 = outside model grid).

Displaying Stochastic Results

|k |[E B | sTOCTEST [ [impact Probabiity ]

When a scenatrio is selected that was run in stochastic mode, then this toolbar will be available
instead of the animation controls. Select the check box and select either Impact Probability or
Amount Ashore to display the color coded probability grid on the map.




A text listing of the stochastic output is also available under the Model menu.

& LACOZOILALOC_DATAMGODA

154 6

54 0

’|

53 24 00

% SHR_PROB....

—._ 4

& Spillet Information
Prey. | Next |

]
J 29

ITYPE 5

Probability 100

VYiscosilty 22434 86

Foreshore Surface Oil 2.50137

Foreshore Sediment Oil 2. 79587

Backshore Oil 1}

Oil in Groundwater 4. 592793

Oil In Surf Zone

2.978725E-03

~ SHDRELINE
P | | PROBABILITY
59 22.80 OF DILING
\ 1> 10
10-> 20
20> 30
30-> 40
53 2160 | e [40 > 50
50 -> 60
60-> 70
70> 80
/ 80> 90 | [
59 20,40 ¥ Mo 100 [ |

Probability grid cells may
be clicked on to obtain
more detailed information.




5. COZOIL Tools

Deleting COZOIL Files

w_File Maintenance _ O] =]
Available Disk
EIDSE SPECE [HB] B5 929216
untitle1_inp - File Type
untitle?_inp (® Trajectory Scenarios
Ci'wind Files
CiGrnid Files

CCurrent Files

I¥elete Eile

To delete unwanted files
created by COZOIL, select
File Maintenance from the
Tools menu. This brings up
the File Maintenance window.
Select the type of file to be
deleted and all existing files of
that type will be listed. From
the list select the file to be
deleted and then click on the
Delete File button. You will be
asked to verify that you really
want to delete the selected file.

Color Keys/Legends

=] NEWKEY.KEW

Title 1
Title 2
Title 3

Label 1
Label 2
Label 3
Label 4
Label 5
Label 6
Label 7
Label 8
Label 9
llLabel 10

To edit a color key, double-click on one of the color key
divisions and the Legend editor will activate.
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The Legend Editor allows the user to edit
the:

titles
each division’s name and color.

Click New Division to add a new
division. Double-click on an existing
division to delete the division.

You may open existing and save color
combinations with the Open Color File
and Save Color File buttons.

The Auto button may also be used to
create a new color combination.

If the legend contains number ranges,
(i.e., 0;2 2;4), then the Auto Division
button allows you to set the first number
and the very last number and create an
even set of ranges between these two
numbers.

=-| Legend Editor

-1~

1].4 Cancel

| Open Color File I
| Save Color File I

PROBABILITY CONTOURS

FOR TIME OF TRAVEL

IN DAYS

|Autn Divizion | |Hew Divisinnl

0.2
2.4
A6
6.8
.81
112
1.2.1.4
1.41.6
1.6.1.8
1.8;2
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6. The COZOIL Database

The COZOIL interface and model use the COZOIL database extensively to obtain
environmental conditions for the region of the spill in the appropriate time of year. This contract
did not edit or change the original COZOIL database in any way.

The directory structure for each location (Arctic, Bering, Goa) in COZOIL is as follows:

| Contentz of 'BACOZ0ILALOC_DATANARCTIC
Mame I Size I Type

[Z Coast File Falder
[ Currents File Folder
[ Fates File Folder
(3 Gis File Folder
([ Grids File Folder
[(Alcons File Folder
3 K.ensz File Falder
CAoi File Folder
(1 Outdata File Folder
1 Rundata File Folder
(O Traj File Folder
(d'winds File Folder
i% Location.ini 1KE  Configuration Settings

The COZOIL database files reside in the Coast directory and are:

Arc_def.del
Arc_fech.txt
Arc_lagn.del
Arc_shor.del
Arc_temp.del
Arc_tide.del
Arc_type.del
Arc_wind.del

(Replace Arc_ with Goa__ for Gulf of Alaska and Ber_ for the Bering Sea.)
Exact descriptions of these files may be obtained by reviewing the original COZOIL
documentation. The way this information is used is summarized below.

Coastline

The Arc_shor.del file contains the segments and sub-segments for the location. These data are
in ASCII format and are not polygonized. ASA used ArcInfo to process these data so that land
polygons may be represented on the map. The Arc_shor file is loaded at initialization and the
segments may be plotted on the map and color coded by shoreline type. Note that the
resolution of the data is less than satisfactory in certain areas.

Shoreline Characterization

Similar to the original COZOIL, a grid system is used to characterize land/water, shoreline type,
and depth. The original COZOIL created a 25x25 grid “on-the fly”; COZOIL 97 uses a
predetermined grid that automatically interpolates shore types and depths from the Arc_shor
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file. Shoreline cells are assigned the type of the nearest coastal segment in the COZOIL
database. Characteristics are used for each shoreline type based on the COZOIL values.

The grid may be up to 250x250 cells and the interface allows the user to create, review, and edit
grids for use by the model. Islands are easily incorporated in the grid. The format of this grid is
the ArcView grid export format (HDR/FLT format). This allows grids to also be created and
edited within ArcView.

Depths

Using the distance offshore values for 1m, 10m, and 20m, the grid creation process determines
the depths of the water cells in the grid. Cells beyond the 20 m bathymetry contour are given the
default depth value specified by the user.

Tidal Range

Tidal range is automatically retrieved from the Arc_tide.del file. The database is searched to find
the shoreline reach nearest to the spill site and the range is used from that reach. The user may
override this value in the model input form.

Currents

The Arc_tide.del file contains tidal current velocity, amplitude and period for each segment.
Similar to the original COZOIL, a current grid was created and values for coastal cells (water
cells beside land) were obtained from the database. However, the COZOIL database lacks
information such as phase (timing of high tide) and direction. Therefore current fields were
generated based on the current speed stored for each shore segment. A vector was generated
and assumed to be parallel to the shoreline (following the original COZOIL). These data have
no phase information and have artificial direction information. Tidal period was also
obtained from the COZOIL database and the COZOIL interface suggests which tidal period to
use based on the location of the spill site and the tidal period in that region.

The coastal cell current values were interpolated over the entire grid field. However, there is no
offshore current information and these data are not reliable.

Winds

The use has two options for wind data:

a Create a wind time series manually,

o Use climatological mean wind speed and direction from the database to generate a wind
time series statistically.

The database is searched to find the shoreline reach nearest to the spill and the wind values
(mean wind speed and direction, and standard deviation of the wind direction from
Arc_wind.del) are used from that reach for the month of the spill.

Air Temperature and Water Temperature

The database is searched to find the shoreline reach nearest to the spill and the temperature
values (from Arc_temp.del) are used from that reach for the month of the spill. The user may
override these values.

Wind Fetch

The database is searched to find the shoreline reach nearest to the spill and the wind fetch
values (from Arc_temp.del) are used from that reach for the month of the spill.

Input File

The COZOIL interface creates an input file called “Scenario”.INP in the RUNDATA directory
under the location directory. This file contains the input parameters for the spill.
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An example listing is:

[COZzOIL]

Scenario=testl
Description=description

Spill Lon=-154.068336011064
Spill Lat=59.1785182315071
Start Year=97

Start Month=4

Start Day=30

Start Hour=10

Start Minute=0

Release Duration=6
Amount Spilled=10000
Simulation Length=24
Number Of Wind Files=1
Climatological Wind=0
Current File=GOA.DIR
Current Components=1

High Tide=6

High Tide Minute=0

Tide Range=4.42

Grid File=SAMPLE.FLT

Oil Name=MEDIUM CRUDE OIL
Oil Units=5

Air Temp=2

Water Temp=4

Ideltat=60

out_intvl=60

ddxy=3

nsp_rls=100

wspil_min=10

wndfactor=3.5

wndangle=0

C_spread=150
thkmin=.0001
c2_mousse=.000002
Nsims=1

Make DBF=-1

Nearest Segment=50.071
Fetch1=10.41

Fetch2=72.66
Fetch3=128.38

Fetch4=0

Fetch5=0

Fetch6=0

Fetch7=0

Fetch8=.89

Wind Speed=1.29

Wind Direction=145

Wind Standard Deviation=85
Windfilel=ZERO_WND.WNE
Wnd1lon=-158.522170509435
Wnd1lat=57.6442738233146
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ASW Import Wind File Format

line 1: station latitude (decimal degrees) Real *4
line 2: NorS (is latitude North or South) Character *1
line 3: station longitude (decimal degrees) Real *4
line 4. Eorw (is longitude East or West) Character *1
line 5: description of data (optional, can be blank) Character *80
line 6: year, month, day, hour (leave a space between each) Integer *2
wind record start
line 7: year, month, day, hour (leave a space between each) Integer *2
wind record ends
line 8: station height, units (height at which measurements Integer *2, character

made, in meters and units of
wind file, supports KNOTS & M/S)
line 9: year, month, day, hour, direction, speed Integer *2
C (Direction, 0°-360°,
Speed in m/sec)

OO0

end

Example

53.4144134521484
N
5.50178252160549E-03
W

DEMONST.WNE
9% 3 97

96 3 11 15

10 KNOTS

96 3 9 7 22 15
96 8 22 15
96 9 68 15
96 10 68 15
96 11 112 15
96 12 112 15

WwWwwww
© © © O o



SHRCHARS3.DAT Shoreline Characteristics File Format
(in COZOIL\location\COAST directory)

ASCII file
Line Variable Comments Variable type
1 Shoretype name e.g., marsh, rocky shore Character *20
2 Maximum oil thickness (mm) 3 values, leave a space Real*4

on beach for oil with kinematic between each
viscosity = 0-30, 30-2000,

>2000 cSt

3 Foreshore length(m), foreshore 4 values, leave a space Real *4
angle, backshore length (m), between each
backshore angle

4 Fraction of oil partitioned to 5 values, leave a space Real *4
groundwater, specific yield of between each

sediment, porosity of
sediment, 50" percentile
grainsize (m), fractional
organic carbon content of
sediment

Repeat these four lines for each shoreline type.
Example

EXPOSED ROCKY SHORE
0.5 2.0 2.0

35 14.0 15 16.9

0. .9 .00001 .000001 .001
GRAVEL/COBBLE/BOULDER
2.0 9.0 15.0

40 6.3 15 5.8

.05 .14 .16 .16 .001



WAYV Offshore Wave Input File Format
(in COZOIL\location\CURRENTS directory)

Unformatted sequential access file

Line Variable Comments Variable type

1 Wave_tide True if file contains tide height, | Logical*1
False otherwise

2 Wave height (m), wave period 4 [or 5] values Real*4
(sec), wave direction (from
North), wave duration (hrs),
[tide height (m)]

Repeat line 2 for duration of wave record to span length of simulation.




.MKV Markov Matrix File Format

(in COZOIL\location\WINDS directory)

ASCII file
Line Variable Comments Variable
type
1 First day and last day of year for which 3 values, leave a Integer
data are valid, hourly interval of original space between each
data from which matrix derived
2 Maximum wind speed (m/s) in each of 5 5 values, leave a Real*4
speed bins space between each
3 Probability that next wind vector will be 41 values, leave a Real *4
from state J, given that present vector is space between each
from state | (I = row number = present wind
state, J = column number = subsequent
state)

Repeat line 3 for each direction/speed bin (for a total of 41 times). See the original COZOIL User’'s Manual
(Reed et al., 1988) for a complete description of how a Markov matrix is generated.

Example

1 366
2.00

.1538
.0000
.0000
.0000
.0769
.0138
.0000
.0000
.0046
.1060
.0000
.0000
.0000
.0000
.0526

1

4.00
.1538
.0000
.0000
.0000
.0000
.3825
.0000
.0000
.0000
.0230
.1203
.0000
.0000
.0000
1165

6.00

.0000
.0000
.0000
.0000
.0000
.0968
.0276
.0000
.0000
.0000
4023
.0000
.0000
.0000
.0414

8.00
.0000
.0000
.0769
.0000
.0000
.0092
.0184
.0046
.0000
.0000
.0902
.0038
.0000
.0000
.0000

.0000
.0000
.0000
.0000
.2308
.0000
.0046
.0000
.0046
.0415
.0113
.0000
.0000
.0075
.0000

15.00

.0769
.0000
.0000
.0000

.0092
.0000
.0000
.0000

.0038
.0000
.0000
.0000

.0769
.0000
.0000
.0000

.1659
.0000
.0000
.0000

.0376
.0000
.0000
.0000

.0000
.0769
.0000
.0000

.0507
.0138
.0000
.0000

.0902
.0000
.0000
.0000

.0000
.0000
.0000
.0769

.0000
.0092
.0046
.0092

.0226
.0000
.0000
.0000

| The first row of the matrix. The 41
| values are the probabilities of the
| subsequent wind speed/direction
| for wind currently from the North

| in the first (< 2 m/s) speed bin.
| The second row of the matrix.

| The third row of the matrix.



(in COZOIL\location\CURRENTS directory)

.DIR Currents Input File Format

Unformatted direct access file

Line Variable Comments Variable type
1 File record length, 6 values. Integer*2 (all)
Number of records in file Minimum file record
(including header), length is 12.
Number of cells in E-W direction
in currents grid,
Number of cells in N-S direction
in currents grid,
Sequence number,
Number of u,v velocity pairs in
record (NVREC)
2 Currents grid cell size in E-W In degrees longitude Real*4 (all)
direction,
Currents grid cell size in N-S In degrees latitude
direction,
Currents grid cell origin in E-W In degrees longitude
direction
3 Currents grid cell origin in N-S In degrees latitude Real*4
direction,
Number of tidal constituents, In degrees latitude Integer*2
Tidal constituent name 1, 2, 3* Character*2 (all)
3 possible values
4 Tidal constituent name 6 possible values Character*2 (all)

4,5,6,7,8,9*

1 for each non-
tidal component

Background current name

Character*10

1 for each grid
cell with current
data

Sequence number,

Grid cell number in E-W
direction (1),

Grid cell number in N-S direction
Q)

Grid cell flag (1=water),

Currents in grid cell as U,V pairs

(in cm/sec) with tidal
components first in list

Integer*2 (all)

*Tidal constituent name must be one of the following 2-character names:




M2, S2, K1, O1, N2, P1, K2, Q1, MF.

The following lines of code are used to read the .DIR file:

READ(NCHYDR,REC=1) NRECL,NDMAX,IMAXC,JMAXC,NSEQ,NVREC
READ(NCHYDR,REC=2) DLONC,DLATC,OLONC
READ(NCHYDR,REC=3) OLATC,NTIDE,(CTIDE(N),N=1,3)
READ(NCHYDR,REC=4) (CTIDE(N),N=4,NINE)

NONTID = NVREC - NTIDE*2

NDREC =4

IF (NONTID.GE.1) THEN
DO N=1,NONTID
NDREC = NDREC + 1
READ(NCHYDR,REC=NDREC) CBAK(N)
ENDDO
ENDIF
NDREC = 4 + NONTID I 4 + NONTID lines of header
DOWHILE (NDREC.LT.NDMAX)
NDREC = NDREC + 1
READ(NCHYDR,REC=NDREC) ISEQO,1,J,IFLGO, (IU(N),IV(N),N=1,NVREC)

ENDDO
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1. INTRODUCTION

COZOIL is an oil spill trajectory and fates model developed for use by the Minerals
Management Service (MMS) in Alaskan coastal waters. It simulates the movement and
weathering of oil spills on open water and in the surf zone, with an emphasis on shoreline
interactions. The present effort updates the original COZOIL model (Reed et al., 1988),
and puts the model on a Windows platform to facilitate entering model parameters and
viewing model results.

This Technical Manual presents an overview of the oil properties and environmental data
used in the model, the gridding system supported, and the implementation of oil fates
algorithms. Details are provided to explain differences between the updated Windows
version of COZOIL and the original COZOIL. This document does not describe the
rationale for the processes and algorithms selected for inclusion in the original COZOIL.
For such information the reader is referred to the original documentation (Reed et al.,
1988). A full description of the user-interface to run COZOIL is provided in the COZOIL
User’'s Manual.

COZOIL for Windows contains several major components: both deterministic and
stochastic oil trajectory and fates models; a Graphical User Interface (GUI) to enable the
user to manipulate inputs, run the model, and view outputs; an oil database with
capabilities to enter and edit oil properties used by the model; and environmental
databases (winds and currents) which store and allow the user to manipulate the physical
forcing data for model simulations. The extensive environmental data collected in earlier
phases of COZOIL development (Gundlach et al., 1990a,b,c) is accessed by the user
interface when a spill scenario is specified; appropriate values for the spill time and
location are selected from the database.

COZOIL was developed to be a powerful tool for investigating the fate of spilled oil in
coastal environments. It can be used to quantify the environmental fate of both real spills
and hypothetical spills. COZOIL has been tested and validated in hindcast simulations of
the Amoco Cadiz spill (Reed et al., 1988) which resulted in heavy shoreline oiling and for
which fairly good observational data exist.

1.1 Physical Fates Model

The physical fates model estimates the mass distribution of oil on the water surface, on
shorelines, in the water column and in the atmosphere. Processes simulated include
surface spreading, slick transport, entrainment into the water column, and evaporation.
Surface slicks interact with shorelines, depositing and releasing material according to
shoreline type and environmental conditions (stage of tide, waves).

The model is designed to simulate fates of crude oils and petroleum products. For
modeling purposes, crude oils and petroleum products are represented by surface
“spillets”, which are very thin circular patches of floating oil. Each surface spillet initially
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represents an equal fraction of the total oil mass spilled, and is weathered (physical and
chemical characteristics change) as the model simulation proceeds.

1.2 Graphical User Interface (GUI)

The model system is implemented on an IBM/PC type computer (486 or greater) with VGA
color monitor running Windows 95. A user-friendly, map-based, graphical user interface
enables the user to view and enter data, run the model, and view model output. The main
window of the GUI is a map of the application area. Geographical data (e.g., currents,
grids) and model output are mapped and animated on the color screen and may be
printed. Tabular information may also be viewed.

1.3 Environmental and Properties Databases

COZOIL requires both environmental and oil property data as input. Each element of the
environmental database is geographically referenced. The following types of data are
included: coastline, bathymetry, shoreline characteristics, currents, winds, fetch, and air
and water temperatures. The system provides data storage and easy access for each of
three geographic areas: Gulf of Alaska, Bering Sea, and the Arctic (Beaufort and Chukchi
Seas) (Figure 1.1). The complete COZOIL database (Gundlach et al., 1990a,b,c) is stored
by location (Gulf of Alaska, Bering, Arctic) in the COAST sub-directory and is sub-sampled
for the required information when the spill scenario is defined. The data system has a user-
friendly interface to allow viewing and editing of data via pull-down menus and mouse-
driven selections.

The updated COZOIL uses a latitude-longitude grid on which to define environmental data
and perform transport calculations. The coastline is defined by the COZOIL shoreline
segments. Shoreline types are projected onto the grid from the extensive COZOIL
database of shoreline segments when a land-water grid is created for the spill area. For a
single spill simulation, the user either supplies a wind time series or selects “Climatological
Winds” in the user interface to generate a time series based on the mean wind statistics.
For a stochastic spill simulation, the user selects either “Climatological Winds” or “Markov
Matrix” to generate statistical winds. Gridded tidal currents generated from the COZOIL
database are supplied for each geographic region. The user also specifies information
about the spill itself (time, location, oil type, amount spilled). The oil database supplies oll
parameters required by the model.
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L Gulf of Alaska (GOA)

Figure 1.1 The three geographic regions covered by COZOIL.

1.4 Differences between the Original and Updated Versions of COZOIL

For the most part, the updated COZOIL is identical to the original COZOIL. Serious efforts
were made to incorporate all the functionality of the original COZOIL in the new Windows
version. The new interface requires the same parameters as used by the original, plus
allows the user to specify a number of other parameters formerly hard-coded in the
COZOIL source code. These additional parameters default to the original hard-coded or
database values if not changed by the user. The user interface greatly simplifies the
process of setting up the model grid, specifying shoreline parameters and currents, and
tracking model simulations. The output of COZOIL has been greatly enhanced to include
colorful graphics for easy visualization of model results, and dBase files for compatibility
with other systems, in addition to retaining much of the original text output.
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A major change to the original COZOIL was adding the ability to include islands in the
model domain. To do this the code was restructured to use solely a gridded
representation of the area of interest. Reach data is projected onto the grid, and
calculations are no longer done by reach. This change resulted in many modifications to
the model code but should be largely transparent to the user.

To facilitate working with the COZOIL source code, much of the model code was “cleaned
up”. For example, model inputs were grouped together in a small set of subroutines to
make input data easier to track. The same process was followed for model outputs. The
code itself was updated in many places to use more recent Fortran constructs. In some
cases subroutines from the original COZOIL were split apart to simplify the calling
sequence or to form new subroutines dealing with the same process. Most of the
functionality of the original COZOIL was maintained, including the oil weathering and
beaching algorithms, the use of RCPWAVE to calculate a nearshore wave field and to
provide input for calculation of longshore currents, and the oil forcing mechanisms (winds,
waves, currents).

The updated COZOIL includes the same weathering processes as the original and for all
processes except evaporation, uses the original algorithms to define the processes. The
evaporation algorithm was changed to update COZOIL with an algorithm which more
realistically reproduces observed evaporation, and for which the input oil parameters are
more readily available. The new algorithm uses a “whole oil” approach, as compared to the
“distillation cuts with associated molecular weight“approach used in the original COZOIL.
The evaporation algorithm is fully described in Section 3.2.2; the required oil parameters
are discussed in Section 2.5.

The ability to create and track subsurface particles was removed from the COZOIL code.
The original COZOIL created a small number (10) of subsurface particles and tracked their
movements. However, nothing further was done with these particles; they had no
interaction with either the surface spillets or shoreline, and consequently had no effect on
model results. Future developments should consider implementing a complete three-
dimensional particle tracking scheme.
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2. DATA

The COZOIL/Windows user interface provides tools for the creation and modification of
land-water grids, wind data, and oil parameters. The gridded tidal currents supplied for
each geographic region can be modified using the tools supplied by the interface.

2.1 Grids

In order for the model to predict the trajectory and fate of oil for a particular area, the map of
that area must be represented in such a way that the model can interpret the various
geographical features.

The division of the environment into discrete "areas" for the purpose of numerical modeling
is attained through the gridding process. The study area in which the model is to operate
is divided into discrete cells on a grid, each having some desired characteristic. The most
fundamental grid for COZOIL is the land-water grid. A rectangular-based grid system
defines the boundary between land and water, the shoreline characteristics of each coastal
cell, and the bathymetry in the gridded area.

Figure 2.1 shows a section of a typical COZOIL land-water grid. The outlined boxes at the
bottom of the figure show the discrete size of the cells that represent the land-water
boundary. Along the shoreline, coastal cells are color-coded by shoreline type. In this
example a key is also shown identifying the different shoreline types.

The user defines the boundaries of the overall grid, and the number of cells in the X and Y
(east-west and north-south) directions. The grid generation routine then automatically
parses the land and water sections of the outlined area. Each cell that intersects a
COZOIL coastal segment is defined as a coastal cell with the characteristics of that
segment.

The smaller the minimum grid size, the finer the definition of the coastline in the area. There
is a finite limit, however, to the number of grid cells COZOIL can manage (250 by 250). In
general, the grid system for any particular trajectory simulation should be only large enough
to contain the area covered by the trajectory, and of the smallest possible grid size to get
the best definition of the coastline.

2-1



8 E:ACOZOILALOC_DATAVARCTIC

= W SHORE KEW
I List| 30.16 =] fNone] ]
Shore Type | SAND BEACH = ExPoSED RoCKY SHORE | [
| Oil on Shore [Metric Tonnes] | ) GRAVEL/COBBLE/BDULDEHR B
- Cozoil Database Informat |PEAT"TUNDHA SCARP
ETE T = SAMD BEACH
Beachi | 31004 L1
Share Type Code 1 MixEp sanp/GRAVEL BEAC [
Length [m] [ 826 | [TIDAL FLAT
Azimuth i 144 i T WETLAND/MARSH
Distance to 20m isobath [0 I LAGDON [
Distance to 10m isobath I_ﬂ_ ! |F||VEH CHANNEL -
Distance to 1m izobath Ilﬂll_
Distance to 33cm isobath | 2305
Backzhore Length [m] |£ B
i Backzhore Slope '1]_ il T
Backshore Angle | 0 Il
Foreshore Length [m] __1] I
Foreshore Slope |£
Foreshore Angle ]
B
] [
70 21 i I2.5 km ]
13Mm

Figure 2.1 Example COZOIL land-water grid .

The grid system is defined by two files created by COZOIL/Windows in a standard
ArcView format: a header file (ASCII) which defines the grid dimensions and location, and
a data file (binary) which defines land and water, and assigns shoreline types to coastal
cells and depths to water cells. The header file has a “HDR” extension, and the data file
has a “FLT” extension. The land-water grid is structured as a standard square grid with
maximum dimensions of 250 by 250 cells. The user may edit the grid to change the land-
water designation, the shoreline type, or the water depth of individual cells.

When a grid is created, the interface automatically generates a companion “SEG” file.

This file contains specific shoreline characteristics (e.g., shoreline type, backshore length
and angle) for each coastal cell in the grid. The COZOIL model uses these data in
calculating the oil-shoreline interactions. If no data are available for a particular coastal
cell, the model uses the default values for that shoreline type (taken from the
SHRCHARS3.DAT file — see the User's Manual for more information). If the user edits the
land-water grid, and either changes the shoreline type of an existing coastal cell, or creates
new coastal cells, the edited/added cells will have the default characteristics for their
shoreline type.
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The fates model uses the land-water grid to determine whether oil is on land or water, and
for shoreline type information. Beyond the limits of the defined grid, the model system
"knows" nothing about the wind, current, or other physical features. Model processes are
undefined outside of the grid boundary.

Shoreline typing is based on the extensive shoreline segment data generated in an earlier
phase of this study (Gundlach et al., 1990a,b,c). The shoreline interaction model in
COZOIL uses this shore specific information to simulate oil stranding and retention (see
Section 3.3).

2.2 Winds

Wind forcing is extremely important in predicting the trajectory and weathering of surface
oil. Wind observations are typically available as time series taken at specific locations.
Such wind time series are used for deterministic model simulations.

The preferred wind record is a wind time series ((WNE file) sampled at hourly intervals at
the site of the spill. This record would include the exact speed and direction of the wind at
the spill site for every hour of the simulation. If a wind time series is not available for the
spill site itself, the next best source of information is a coastal wind station close to the spill
site, such as a local airport. It may be important to consider local topographic effects at the
wind station. Large hills or mountains in the vicinity of the coastal wind stations can limit
the representativeness of the wind data for large areas.

Winds are represented in the COZOIL system by single point (station) time series records.
The model assumes a uniform wind field over the study area. Since study areas are
generally expected to be small (e.g., 100 km alongshore and 1-20 km offshore), spatial
variability in the wind field generally will be difficult to resolve from typically available data.

For stochastic simulations COZOIL can use either a zeroth or first-order Markov process to
generate winds. For a zeroth order process COZOIL uses the mean and standard
deviation of the wind speed and direction from the database to generate winds. The wind
speed is drawn from a Poisson distribution; wind direction is assumed to be uniformly
distributed. The procedure neglects autocorrelations in the wind record. To generate a
zeroth order wind time series for use by the model, select the “Climatological Winds”
option when specifying the spill scenario.

To generate winds using a first-order Markov process, the user must supply a Markov
matrix (.MKYV file). The Markov matrix provides the probability of winds in each of eight
directional bins for each of five speed bins plus a bin for calm conditions based on the
wind’s speed and direction the previous time interval. The matrix is thus a 41x41 array of
probabilities of the wind’s speed and direction given its previous speed and direction.
This allows a more realistic time series to be generated since correlations between speed
and direction are maintained, and wind speed and direction distributions are more
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accurately represented.

2.3 Currents

Gridded tidal currents are provided for each of the three geographic regions of COZOIL.
The gridded data were generated from the COZOIL database of tidal current by coastal
segment. The database provides no information on direction which has been assumed to
be shore parallel. These currents can be used as-is in model simulations, or edited using
the appropriate COZOIL tools described in the User's Manual. If the land-water
designation of individual cells is changed or current vectors are added/adjusted, the current
field should be re-generated by first spreading the data to fill in missing values and then
smoothing the current field. The spreading algorithm generates a simple average of the
neighboring grids to the north, south, east and west and the diagonal grids to the northeast,
southeast, southwest, and northwest. The averaging occurs in a series of passes through
the grid. First only those grids with eight neighboring values are filled with the average.
The next pass fills grids with the average of seven neighboring values, the third pass with
the average of six neighboring values, and so on, until the final pass fills grids with one
neighbor. At the conclusion of this process all grids are filled. The method works best
when the specified vectors are distributed throughout the area of interest, particularly along
the boundaries.

Once the data have been interpolated onto grids, it is possible to smooth the fields beyond
what the interpolating function naturally does. An option allows smoothing of the entire grid
including the directly entered data, or smoothing of only the interpolated values. Here a
four point neighbor weighting algorithm is applied multiple times as follows:

1l-a
q?‘”=aq{“+—(4)(q2‘+q% g5t o)
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where

a = weighting factor
(0.75 when the entire grid is smoothed)
(0.0 when just interpolated values are smoothed)

o] = value at grid point i
Oe,0w,0s,On = grid neighbors of grid point i to the east, west, south, and north,
respectively
m = number of smoothing passes.
2.4 Waves

Two types of waves are calculated in the model: an offshore wave and a wave field that
includes refraction, diffraction, and phase transformations. The offshore wave is assumed
to apply at the open boundary of the model grid and supplies the boundary condition for the
wave field calculations. Both types of waves are calculated and used exactly as was done
in the original COZOIL. Full documentation of the equations implemented for wave
calculation is presented in the original documentation (Reed et al., 1988) and is
summarized briefly here.

The offshore wave can either be calculated internally from the wind record, or be read in
from a wave time-series file specified by the user. The wave is defined by its height,
period, and direction of propagation. If the wave is to be calculated internally, the model
uses the shallow-water, wave forecasting equations recommended by the Shore Protection
Manual (CERC, 1984).

Refraction, diffraction, wave height, and phase transformations are computed using a
modified version of the CERC linear wave propagation model RCPWAVE (Ebersole et al.,
1986). Discussion of the theory and algorithms used by RCPWAVE is given by Ebersole
et al. (1986) and Reed et al. (1988).

2.5 Oil Database

The oil properties database includes physical-chemical parameters for several oils. The
oils included in the standard database are generic light, medium, and heavy crudes,
Prudhoe Bay crude, gasoline, diesel, JP-4, and Bunker C (#6 heavy fuel oil). These crude
and refined products exhibit the range of weathering processes for most oils. Specific
crude and refined product analyses can be entered to define specific oil characteristics.

The standard source for physical and chemical parameters describing crude and refined
oil products is Environment Canada's A Catalogue of Crude Oil and Oil Product Properties
(Whiticar et al., 1992). This volume undergoes yearly updating, and is available in both text
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and electronic formats. The information is also available through an Internet URL @
http://www.etcentre.org/spills. The following information on oil properties is extracted from
the above reference. A short description is given for each of the physical and chemical
parameters below.

2.5.1 General Parameters

A series of general oil-related parameters are required to run COZOIL. Parameter values
can be obtained from the Canadian catalog. In the following sections each required
parameter is defined.

API Gravity
The most commonly used descriptor of oil properties is the API gravity. The API gravity
value is inversely proportional to the oil's density. While COZOIL does not use the API

gravity directly, the API value for a particular oil or product is useful as a parameter to
compare oils. Itis defined as

1415

API = —— -1315
(9) D
with
D=r,/r,
where
ro - density of oil @ 60°F
e - density of water @ 60°F.

Typical API gravity values are shown in Table 2.1.
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Table 2.1 Typical API(g) values for various oils and oil products.

Oil/Qil Product API(g9)
Naptha 49 - 67
Gasoline 58 - 68
Kerosene 34 -45
Arabian Light 32-33
#2 Fuel Oil 30-32
Iranian Heavy Crude 30-31
10W30 Crankcase Oil (used) 28

Prudhoe Bay Crude 27

Cold Lake Bitumen 10

Density

Density is defined as the mass of a unit volume of oil at a specified temperature. Although
specified as a constant the oil density is a function of temperature and weathering
(Mackay, 1985) and has units of g/cm®. COZOIL uses density and not API gravity in the
model calculations.

Dynamic Viscosity

Viscosity is a measure of a fluid's resistance to flow. It is also a function of temperature
and weathering (Mackay, 1985) and has units of centi-poise (cP).

Interfacial Tension

Interfacial tension is the force of attraction between the molecules at the interface of two
dissimilar fluids. The property is important for spreading and emulsification formation. Itis
a function of weathering and has units of dyne/cm.

Emulsion Water Content

A water-in-oil emulsion (colloquially named "chocolate mousse") is a stable emulsion of
small droplets of water incorporated in oil. Oil spilled on a water surface may form stable
water-in-oil emulsions which can have very different characteristics than the parent oil.

Not all oils form stable emulsions. The tendency for a crude oil to form a water-in-oil
emulsion is measured using a test method based on a rotating oscillating flask apparatus.
An oil and water mixture is agitated and the fraction of oil that forms an emulsion is
determined by measuring the height of the unemulsified oil and comparing it to the original
height of the oil.
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The water content of the emulsion is calculated by measuring the height of the emulsion,
subtracting the height of the oil that has been emulsified, then dividing this value by the total
height of the emulsion. It has units of percent.

Minimum Thickness

The minimum thickness is an estimate of the end state of the spreading process. Once the
oil in a spillet has reached the minimum thickness, the model assumes that no more
spreading of oil in that spillet will occur. This is an inexact estimate, and ignores much of
the dynamics of the actual spreading process. The assumed minimum thickness for
several different oils is given in Table 2.2.

Table 2.2 Assumed minimum oil thickness for selected oils.

Qil Minimum Thickness
Diesel 0.001 mm
light crude 0.001 mm
med. Crude 0.01 mm
heavy crude 0.10 mm
Bunker C 0.10 mm

2.5.2 Evaporative Exposure Parameters

Evaporation is one of the more important weathering processes that affect oil in the
environment. A well documented analytical approach is used in COZOIL to predict the
volume fraction of oil evaporated. The approach is based on the evaporative exposure
concept (Stiver and Mackay, 1984). The following evaporative exposure parameters are
contained in the oil database:

To - Initial boiling point (K)

Te -  Gradient of modified distillation curve
A - Dimensionless constant

B - Dimensionless constant.

T, and T are the y-intercept and slope, respectively, obtained by linearly regressing a
specific oil's boiling point temperature versus the volume fraction distilled.

A and B are dimensionless constants determined as the y-intercept and negative slope,
respectively, obtained from a linear regression of the natural log of Henry’s Law constant
versus the boiling temperature.

Details on the use of these parameters are found in Section 3.2.2. The parameters
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defining Prudhoe Bay Crude are given in Table 2.3.

Table 2.3 Parameters defining the characteristics of Prudhoe Bay crude.

GENERAL PARAMETERS

Density (gm/cm?) 0.899
Dynamic Viscosity (cP) 35.3
Solubility (mg/L) 29.2
Oil-Water Interfacial Tension (dyne/cm) 20.
Emulsion Water Content (%) 70.
Minimum Thickness (mm) 0.001
Viscosity Weathering Constant 10.

MACKAY EVAPORATIVE EXPOSURE

Initial Boiling Point (K) 430.6
Gradient of Distillation Curve 722.

A 45
B 10.1
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3. OIL TRAJECTORY AND FATES ALGORITHMS

COZOIL predicts the surface trajectory of spilled oil while maintaining a mass balance of
the fate of the oil (weathering) with a particular emphasis on shoreline interactions. Spills
may be either instantaneous or continuous releases. The spill is initially represented by a
number of particles, termed spillets, each of which represents an equal fraction of the total
oil spilled.

Spillets in open water are advected in response to wind and current forcing with trajectory
(path) and final destination of the oil. Section 3.1 describes the advection algorithms. At
the same time, the oil evaporates, spreads, is entrained into the water column, emulsifies
and interacts with the shore in coastal regions. Together these processes affect the
physical-chemical state of the oil and its distribution/degradation in the environment and
are termed the weathering (or fate) of the oil. The COZOIL fates algorithms are detailed in
Section 3.2, and shoreline interaction is described in Section 3.3.

3.1 COZOIL Transport Algorithms

Advection and diffusion are physical processes which move and diffuse oil from one
location to another due to the combined action of wind, waves, and tides. The advection
process is modeled using a Lagrangian formulation. The diffusion process is modeled
using a random walk formulation. Both are described in the following sections.

As one of the fundamental hypotheses defining the COZOIL spill model, it is assumed that
the oil spill can be divided into a number of discrete masses (spillets) and can be treated
as Lagrangian patrticles, each representing some known mass of oil. The vector position of
an oil particle at time t is denoted as X; and defined as

Xi = Xi1 + DU

where

Dt -time step (sec)
Xw1 - position of surface slick at t-1 =t - Dt
Uoii - slick velocity (m/sec).

The total particle velocity, Uy (m/sec), is defined as the vector sum of the advective and
dispersive velocity components:

Uil = Uy + Uy + Uis + Ugisp

where
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U: - velocity component due to tidal currents (m/sec)

U, - velocity component due to wind and waves (m/sec)

Uis - velocity component due to longshore currents (m/sec)

U; - velocity component due to dispersive processes (m/sec).

3.1.1 Advection Due to Tidal Currents

The original COZOIL used the database of tidal current data by beach segment to calculate
a gridded tidal current field each time a new simulation was run. This process is now
externalized. For each geographic region a gridded current field has been generated from
the tidal current database. Tidal currents are assumed to be shore-parallel and the tidal
period is maintained. Phasing information was not included in the database and thus is
not incorporated.

The advective velocity component due to tidal currents, Uy, is determined from the gridded
current data by interpolation. The interpolation is based on a weighting scheme of the four
nearest points of the velocity grid from the oil particle location shown in Figure 3.1. The
actual interpolation algorithm is

D - U|’JA|+1,J+1 + U|+1'JA|,J+1 + U|’\]+1AI+1,J + U|+1’J+1A|,J
Al,J + A|+1,J + Al,J+l + A|+l,.]+l
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Figure 3.1 Area weighting scheme for velocity interpolation.

3.1.2 Advection Due to Wind and Waves

The sea surface drift current is a major component affecting the movement of surface oil.
The drift current includes the effects of both wind induced shear and wave induced
transport which are related to the wind speed and direction.

The drift rate is the ratio of oil drift speed relative to the wind speed. Drift velocities due to
a wind, u, and vy, (m/sec), toward the east and north, respectively, are

Uwc = C1 Uy
Ve = C1 Viy
where

Uw - east component of wind speed (m/sec)
Vw - north component of wind speed (m/sec)
Ci - drift factor (%).

The drift factor, C,, is constant (Lange and Hufnerfuss, 1978), where C1 varies between 1.0
and 4.5%, based on observations. Values of 3-3.5% are most often used for moderate
winds in open water areas. Lower values are often used in enclosed and semi-enclosed
embayments. The default value in the model is 3.5%, consistent with the original COZOIL.
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The drift angle is the angle the oil drifts clockwise (to the right in the northern hemisphere)
of the wind direction.

Drift velocities due to wind, u,q and v,,q (m/sec), toward the east and north, respectively, are
Uwd = Uwe COS O+ vy SINQ
Vwd — ~Uwe sin q + Vwe COS Q
where
Uwg - drift velocity due to wind (m/sec) toward the east
Vwa - drift velocity due to wind (m/sec) toward the north
g - constant drift angle (deg).
Various researchers have measured a wide range of drift angles (from O to 13 degrees)
based on laboratory and field experiments and spill hindcasts (Stolzenbach et al., 1977).

The default value in the model is 0. It can be adjusted if necessary to align model results
with observations.

3.1.3 Advection Due to Longshore Currents

The advective velocity component due to longshore currents, Uy, is active (non-zero) only in
the surf zone. Longshore currents are calculated for each nearshore grid cell according to
the modified Longuet-Higgins radiation stress equation (CERC, 1984):

Uis=20.7 m (g Hp)*®° sin2a,
where
m - beach slope
g - acceleration due to gravity

Hy - breaker height
a, - angle between breaker crest and shoreline.

The breaker height and angle are generated by RCPWAVE. A complete discussion of
RCPWAVE is given in the original COZOIL technical documentation and is not repeated
here.

3.1.4 Advection Due to Dispersion

The horizontal dispersion velocity, Ugisp, accounts for the dispersive processes below the
scale of resolution of the input current field. For a discussion of these dispersive
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processes see Okubo and Ozmidov (1970). Dispersion is modeled using a random walk
diffusion process.

The slick diffusive velocities, Ugg and Vg4, (m/sec), in the east and north directions,
respectively, can be defined (Bear and Verruijt, 1987) as

6D«
U = 9 D
6D
Vaa = 0 uy

Dx - horizontal dispersion coefficient in east - west direction (m2/sec)
Dy - horizontal dispersion coefficient in north-south direction (mzlsec)
Dt - time step (sec)

g - random number (-1to +1).

The horizontal dispersion coefficients, D, and D, are usually equal. Following are some
typical values:

Environment Dispersion Coefficient
Highly energetic open environment > 10 m*/sec
Medium energy levels 5-10 m*/sec
Low energy levels (enclosed estuary) 2 -3 m?/sec

3.2 COZOIL Fates Algorithms

The COZOIL trajectory and fates model integrates the trajectory algorithms (Section 3.1)
with a series of fates algorithms simulating what happens to the oil as it weathers. The fate
processes simulated are spreading, evaporation, entrainment, emulsification, and
shoreline interactions. These calculations make possible a mass balance calculation which
tracks the fraction of oil on the surface, in the water column, in the atmosphere, stranded
onshore and transported out of the spill area over the life of the spill.

3.2.1 Spreading

Spreading determines the areal extent of the surface oil, which in turn influences its rates of
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evaporation, dissolution, dispersion and photo-oxidation, all of which are functions of
surface area. Spreading results from both turbulent diffusion and the balance among the
forces of gravity, inertia, viscosity, and surface tension.

For many years Fay's (1971) three-regime spreading theory was widely used. Mackay et
al. (1980a,b) modified Fay's approach and described the oil as thin and thick slicks. Their
approach used an empirical formulation based on Fay's (1971) terminal spreading
behavior. They assumed the thick slick feeds the thin slick and that 80-90% of the total
slick area is represented by the thin slick.

The rate of change of the surface area of the slick for thick slick spreading (Mackay et al.,
1980a,b), A, (m°/sec), is defined as

4/3
Aw = —= = Ki Al® &=

dt YW

where
A - surface area of slick (m2)
Ky - spreading rate constant (1/sec)
, 3
Vm - volume of surface slick (m™)
t - time (sec).

Sensitivity analyses of this algorithm led to the discovery that the solution was affected by
the number of spillets used. The following formulation was derived to normalize the solution
under differing numbers of surface spillets (Kolluru, 1992).
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The rate of change of the surface area of an individual spillet, Aotk (mzlsec), is given by

L4l3 .43
dA« 13 &m0  aRs0

K = = 1
Aw = Tgr T ARG &R
where
Atk - surface area of individual spillet (m2)
K1 - spreading rate constant (1/sec)
Vm - volume of oil in individual spillet (ms)
Rs - radius of individual spillet (m)
Re - effective radius of surface slick (m).

The effective radius of the surface slick, Re (m), is given by

€x6lo o u
Re = = A A
@po & Y

N 1/2
=1

where
Atk - surface area of individual spillet (m2)
N - number of spillets used to represent surface slick.

3.2.2 Evaporation

Evaporation can result in the transfer of 20-40% of spilled oil from the sea surface to the
atmosphere, depending on the type of oil (Gundlach and Boehm, 1981). The rate of
evaporation depends on surface area, thickness, vapor pressure and mass transport
coefficient, which in turn are functions of the composition of the oil, wind speed and
temperature. As oil evaporates, its composition changes, affecting its density and
viscosity as well as subsequent evaporation. The most volatile hydrocarbons (low carbon
number) evaporate most rapidly, typically in less than a day and sometimes in under an
hour (McAuliffe, 1989). As the oil continues to weather, and particularly if it forms a
water/oil emulsion, evaporation will be significantly decreased. Evaporation models
assume the oil to be well-mixed within the slick. For thick, viscous slicks, the well-mixed
assumption is not valid, and virtually fresh oil may remain for several days or even weeks,
trapped within viscous oil-water emulsions.

A schematic of the evaporation process is shown in Figure 3.2.
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The evaporative exposure model (Stiver and Mackay, 1984) is an analytical approach to
predict the volume fraction evaporated. It uses distillation data to estimate parameters
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Figure 3.2 Schematic diagram of the evaporation process.

needed for the analytic equation.

The fraction evaporated, F,, is defined as

where

In [1+B(Tc/T)q exp (A - BT, /T)]
[T/BTg]

\

initial boiling point of the modified distillation curve (K)

gradient of the modified distillation curve

environmental temperature (K)

dimensionless constants (for "typical” crude oils A =6.3, B =10.3)
time (sec)

evaporative exposure.

The evaporative exposure, g, is given as
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_aKy AtO

Vo 2
where
Km -  mass transfer coefficient (m/sec)
A - slickarea (m?
t - time (sec)
Vo, - volume of oil spilled (m®).

Distillation data (T, Tg, A, B) for many crude oils are available in Environment Canada's oil
catalog (Whiticar et al., 1992). These data can also be estimated according to the
following procedures.

Estimation of To and Tg

To (y-intercept or initial boiling point) and T¢ (slope or gradient) are obtained by plotting
(linearly regressing) boiling temperature (Tg) versus volume fraction distilled (F,) for a
particular oil. The relationship between Tg and F, is shown in Figure 3.3 and is described
as

Te=To+Tc Fv
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Figure 3.3 Relationship of boiling point temperature to fraction evaporated (Stiver
and Mackay, 1984).
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Estimation of A and B

A (y-intercept) and B (slope) are obtained by plotting the natural log of Henry's law
constant, H, against boiling temperature (Tg) as shown in Figure 3.4. Henry's law constant,
H, is defined as the ratio of the concentration of oil in vapor phase to liquid phase. Itis
obtained from laboratory based evaporation experiments and is defined as a
dimensionless constant:

H=PV/RT
where
P - vapor pressure of oil (atm)
R - universal gas constant
T - ambient temperature (K)
L3
V - volume of oil (m").

H is often given in units of atm - m*mole. It is divided by RT to nondimensionalize it. The
relationship between H and Tg is

InH = A - BgeTb‘?
To

O NORMAN WELLS
& KUWAIT
A MURBAN

InH=6.3-10.3 Te/T
A=6.3

12+ B=103

-14
350 400 450 500 550
BOILING TEMPERATURE T, (K)

Figure 3.4 Relationship of Henry’s law constant to boiling point temperature (Stiver
and Mackay, 1984).
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3.2.3 Entrainment

As oil on the sea surface is exposed to wind and waves, it is entrained or dispersed into
the water column. Entrainment transports small (macroscopic) particles of oil into the water
column where they further degrade and dissolve or disperse, or rise back to the surface.
The increased surface area represented by these droplets increases the rates of
dissolution and photo-oxidation (Wheeler, 1978). Entrainment is strongly dependent on
turbulence and is greater in areas of high wave energy. Breaking waves are the primary
source of energy for entrainment. Figure 3.5 presents a schematic of the entrainment
process.

BREAKING WAVES
NON-BREAKING WAVES

INPUT FLUX
j RISING
LARGE
WELL DROPS
MIXED
LAYER SMALL DROPS
RISING
50 CM SMALL
DROPS
Y
A
LESS WELL
MIXED
DIFFUSIVE SMALL DROPS
LAYER DIFFUSING
PERMANENTLY
10 M TO LOWER LAYER
\ DIFFUSION FLOOR

Figure 3.5 Schematic diagram of entrainment process (Mackay et al., 1980a).

Two options are available in COZOIL for simulating entrainment: one developed by
Mackay et al. (1980a,b) and a second developed by Audunson (1979) and modified by
Spaulding et al. (1982).

The Mackay et al. (1980a,b) algorithm gives a mass transfer rate (per hour) of

dm _ 01Im(1+ W)?
dt  1+50nt°ds
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where

m - mass of spillet (mt),

W - wind speed (m/sec),

m - dynamic viscosity of oil (cP),

d -slick thickness (m),

s - oil/water interfacial tension (dyne/cm).

The modified Audunson entrainment algorithm predicts a mass transfer rate (per day) of

dm _ 04mw?e **
dt W’

[o]

where

m - mass of spillet (mt),

t -time (days) since spillet release,
W - wind speed (m/sec),

W, - reference wind speed (8.5 m/sec).

3.2.4 Emulsification

The formation of water-in-oil emulsions, or mousse, depends on oil composition and sea
state. Emulsified oil can contain as much as 80% water in the form of micrometer-sized
droplets dispersed within a continuous phase of oil (Wheeler, 1978; Daling and Brandvik,
1988). Viscosities are typically much higher than that of the parent oil. The incorporation
of water also dramatically increases the oil/water mixture volume.

Although many studies have been undertaken, the emulsification process is still poorly
understood. The formation tendency and stability of water-in-oil emulsions appears to be a
function of the oil's asphaltene and wax content (Bobra, 1991). Refined products typically
do not form stable water-in-oil emulsions due to the absence of surface active materials
(Payne and Phillips, 1985a,b).

Emulsion formation is a result of surfactant like behavior of the polar and asphaltene
compounds. These compounds are stabilized in many crude oils by the aromatic solvents.

As aromatics are depleted due to weathering, asphaltenes begin to precipitate.
Precipitated asphaltenes reduce the surface tension of the oil-water interface and initiate
the emulsification process.

Water enters the oil phase by the disruption or deformation of the oil-water interface.

Deformation of the interface may take place due to turbulence, capillary ripples, Rayleigh-
Taylor instability and Kelvin-Helmholtz instability. Water droplets in the oil phase are
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stabilized by the precipitated asphaltenes. The emulsification process is shown
schematically in Figure 3.6.

FORMATION OF DROPLET
INTERFACIAL FILM FORMATION
WATER-IN-OIL
EMULSION
WATER ° 0 ° ¢ OIL-IN-WATER
°0 o 0 0 R EMULSION
[ () . 00 o
DEFORMATION OF STABLE
INTERFACIAL FILM WATER-IN-OIL EMULSION

WATER

Figure 3.6 Schematic diagram of the emulsification process.

The exponential rise mousse formation algorithm is presented by Mackay et al. (1982).
The rate of water incorporated into oil, E _(sec™), is given as

~ dec 2 ai ch
= — = C w
Fre = Tt t € e
where
Uy - wind speed (m/sec)
C, - empirical constant:

2x10° for emulsifying oil
O for others
C, - constant controlling the maximum water content:
0.7 for heavy fuel oil and crude oll
0.25 for home heating oll
Fwe -  maximum fraction of water in oil (0il characterization input value).
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The viscosity of the emulsified oil, m(cP), is given as

& 25F, O
m = m exph+
1- Co chz
where
my - initial oil viscosity (cP)
Fwe -  maximum fraction of water in 0ilC, - emulsification constant (»0.65).

The effect of evaporation on viscosity is given by

m = m exp(C. F)

where
my - initial oil viscosity (cP)
C, - constant:
1 - for light fuels
10 - for heavy fuels
F, - fraction evaporated from surface slick.

The exponential rise approach developed by Mackay et al. (1982) has been used for many
years by oil spill modelers. It was derived from laboratory data and works well only for
heavy crude oils.

3.3 COZOIL Shoreline Algorithms

The fate of spilled oil that reaches the shoreline depends on characteristics of the olil, the
type of shoreline, and the energy environment. Even when beached, oil will continue to
weather. However, several additional processes become important: reflotation,
penetration into the substrate, and retention/transport in the beach-groundwater system.
Erosion of oiled substrate from the beach may also occur. These coastal processes have
been parameterized in COZOIL, as discussed in the following sections. They are shown
schematically in Figure 3.7.
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Figure 3.7 Schematic diagram of shoreline interaction.

The amount of oil which can be deposited onshore is a function of the area of the shore
exposed to tide and wave action. COZOIL defines a beach width and angle (slope) for
each type of shoreline, which is then used in the calculation of exposed area. Default
values for each of the three geographic regions covered by COZOIL are given in Table 3.1.
These values are taken from the appropriate COZOIL shoreline characteristics handbook
for each region (Gundlach et al., 1990a,b,c).
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Table 3.1 Default beach width and angle by shore type and geographic region.

Geographic Foreshore Backshore
Region Shore Type Width (m) | Angle | Width (m) | Angle
Arctic 1. Exposed rocky shore 25 11.2 30 8.1
2. Gravel/cobble/boulder 15 10.0 25 35
3. Peat/tundra scarp 30 32.4 30 32.4
4. Sand beach 20 3.2 35 14
5. Mixed sand/gravel 20 6.1 25 2.2
6. Tidal flat 80 04 80 04
7. Wetland/marsh 35 3.6 20 2.1
Bering Sea | 1. Exposed rocky shore 25 11.2 30 8.1
2. Gravel/cobble/boulder 50 4.7 15 11.1
3. Peat/tundra scarp 55 2.2 15 0.2
4. Sand beach 50 4.9 45 0.3
5. Mixed sand/gravel 40 49 30 34
6. Tidal flat 80 04 80 0.4
7. Wetland/marsh 35 3.3 25 5.3
Gulf of Alaska | 1. Exposed rocky shore 35 14.0 15 16.9
2. Gravel/cobble/boulder 40 6.3 15 5.8
3. Peat/tundra scarp 55 2.2 15 0.2
4. Sand beach 155 2.3 45 4.3
5. Mixed sand/gravel 50 5.7 20 5.3
6. Tidal flat 140 04 30 1.0
7. Wetland/marsh 35 3.3 35 5.3

3.3.1 Deposition on Foreshore Surface

An olil slick which has contacted the shoreline may deposit oil on the foreshore if the water
level (tide height plus wave setup and runup) does not exceed the foreshore height
associated with that reach. First, the model checks to determine that an empirical “holding
thickness” (Table 3.2) (CSE/ASA/BAT, 1986; Gundlach, 1987) has not been exceeded for

the coastal cell in which contact has occurred. When the tide is falling, the ratio of the newly

exposed beach face to the onshore/offshore radius of the slick determines the fraction of
the slick which is deposited, if the holding thickness has not been reached.
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Table 3.2 Maximum surface oil thicknesses for various beach types as a function of oil
viscosity (CSE/ASA/BAT, 1986).

Oil Thickness (mm) by Oil Type
Shore Type Light Medium Heavy
(<30 cSt) (30-2000 cSst) (>2000 cSt)
1. Exposed rocky shore 0.5 2 2
2. Gravel/cobble/boulder 2 9 15
3. Peat/tundra scarp 0.5 2 2
4. Sand beach 4 17 25
5. Mixed sand/gravel beach 2 9 15
6. Tidal flat 3 6 10
7. Wetland/marsh 6 30 40

Example oil types are:

Light - kerosene, gasoline, diesel fuel
Medium - medium to light crude oils and light bunkers
Heavy - heavy bunker oils, heavy and weathered crude

Oil deposited on a previously clean foreshore carries with it the characteristics of the

parent slick (i.e., viscosity, density). As additional oil comes ashore at the same location,

whether from the same or another spillet, the oil on the foreshore surface takes on the

weighted average values of the above characteristics. If, for example, a mass of new oil is
added which equals 10 percent of the mass already present, then the new characteristics

will be 10/110, or about 9 percent those of the new oil, and 91 percent those already
present. This represents an assumption of complete mixing and is consistent with
assumptions made elsewhere in the model.

3.3.2 Deposition on Backshore

If the water height exceeds the input foreshore height, then a slick in contact with the
shoreline will deposit oil on the backshore. As on the foreshore, the fraction of the slick
which is deposited is determined by the ratio of newly exposed backshore to slick width
and is again limited by a maximum holding thickness.
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3.3.3 Entry Into Sediment/Groundwater System

Observational evidence from several major oil spills (particularly the Arrowin Canada and
the Amoco Cadiz in France) indicates that oil, in association with the groundwater within
beaches, may persist for several years. Vandermeulen and Gordon (1976) reported
observations of oil associated with groundwater resulting from the Arrowoil spill Nova
Scotia. An estimate of the general level of oil released from the sediments was presented,
indicating runoff losses in the part-per-billion range. Self-cleaning of incorporated oil was
estimated to take as much as 170 years indicating the possible long-term nature of the
problem.

Study of the Amoco Cadiz oil spill indicated that numerous beaches and tidal flats
contained polluted groundwater long after the beach surface was free of oil. A survey in
August 1986, 8.5 years after the spill, revealed that contaminated ground water still was
present in some sheltered (and very soft) mudflat areas and associated with remaining
cleanup trenches. On beaches, in contrast to mudflats, the most common areas for oil-
contaminated groundwater to be found were at the base of the beach (slightly above the
toe of the beach) or along the upper part of the low-tide terrace. These areas generally
conformed to the surface waters of the zone of saturation. On mudflats, oil was
incorporated within the soft, water-saturated sediments wherever substantial surface
concentrations of oil had occurred.

The processes governing oil incorporation and movement within beach sediments and
groundwater are not fully understood. However, by utilizing a series of formulations
originally developed to predict fluid transport through land-based groundwater systems, it is
possible to develop a computer-simulation model depicting penetration into beaches and
subsequent removal or flushing of oil from this system.

The two concepts of wettability and capillarity are relevant here. Relative to oil, water is a
“wetting fluid” [i.e., the adhesive forces between the fluid and the sediment exceed the
cohesive forces within the fluid (Convery, 1979)]. Wettability is a relative term, defined
technically as a balance among the relevant surface tension forces. A pressure difference
exists across the interface between two immiscible fluids in a porous medium. The
curvature of the interface reflects the magnitude of this pressure difference, called the
capillary pressure. This pressure is a measure of the tendency of the sediment to draw in
the wetting fluid (water) and to repel the nonwetting fluid (oil).

Three different regimes of fluid saturation can be distinguished (Convery, 1979). At very
low saturations, the wetting fluid exists as pendular rings around grain contacts within the
porous medium. These rings of fluid are completely isolated from one another, except
perhaps for a thin film of wetting phase that coats the grain surface. This film, present at
extremely low saturations, occurs on surface adsorption sites on the sediments. The film
has a monomolecular thickness and may be continuous or discontinuous. Hydraulic
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pressures cannot be transmitted through the wetting fluid in the pendular regime, since it is
not continuous. In our analysis, the wetting fluid is water and the nonwetting fluid is oil.

If the saturation of the wetting phase increases, the pendular rings expand and coalesce,
so that flow of the wetting phase is possible. Coincidental with this development is a
decrease in the saturation of the nonwetting phase. This saturation regime is labeled
funicular. The phase distribution and flow behavior of fluids in the funicular regime are
complex and are strongly a function of the saturation history of the porous medium.

With increasing saturation of the wetting phase, the nonwetting phase eventually becomes
discontinuous. Commonly, droplets of the nonwetting phase become isolated in the larger
pores of the medium. The nonwetting phase is in a condition of insular saturation.
Nonwetting phase droplets become mobile only if a pressure discontinuity exists across
them within the wetting phase to force them through capillary restrictions. Otherwise, the
droplets are immobile and remain trapped within the pores. The insular drops will impede
flow of the wetting phase to some extent.

For implementation in COZOIL only two regimes, the pendular and the insular, occurring at
the foreshore surface in the presence of oil and in the zone of saturation, are used (Figure
3.8). This neglects some interfering complexities, such as pore blockage by oil in the
funicular regime, allowing the characteristics of the oil to control flow computations at the
foreshore surface and water to control within the beach.

FORESHORE << T = BACKSHORE

HIGH WATER (plus wave runup) OIL LAID UP BY WAVES N

OIL LAID ON BY TIDAL ACTION;
MEAN SEALEVEL _ _ _ _REFLOATED NEXT TIDE
PIVOT POINT
LOW WATER

MINIMUM GROUNDWATER LEVEL
ZONE OF
RESURGENCE MEAN DEPTH OF WATER TABLE

Figure 3.8 Schematic diagram of the beach groundwater system.

In the present analysis, it is assumed that oil deposited on the beach foreshore may enter
the sediment/groundwater system in two ways—the first by direct penetration and the
second by transport in wave overwash. The second process assumes that waves breaking
and overwashing oil on the foreshore will carry with them dissolved and particulate (“water-
accommodated”) oil. This water-accommodated oil is assumed to travel into the
sediments with, and at the same rate as, the water itself.
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3.3.4 Direct Penetration of Oil into Sediments

The flow of oil from a surface deposit into the underlying sediments is approximated by
Darcy’s law: ahé

) par gm

P m

where

vV, - flow velocity (m/sec)

p - intrinsic permeability of the sediment (m?)
g - gravitational acceleration (m/sec?)

r - oil density (kg/m®)

m -  dynamic viscosity (N-sec/m?)

d

— - pressure head gradient (m/m).

The intrinsic permeability is computed with an equation from Krumbein and Munk (1943):

p=7.6x10" (MG)’e™*"

where
MG - mean grain size (mm)
S - inclusive graphic standard deviation (f units).

The depth of penetration during a time-step Dt is then, to first order, v,Dt. The mass flux

Qis:

Q=Ar v, Dt

Here, A is the surface area covered with oil.

3.3.5 Removal of Surface Oil by Wave Overwash

Observations by Owens et al. (1983, 1987) suggest that wave exposure is an important
parameter for oil removal from the beach surface. An expression is therefore required for
the rate at which oil is removed from the parent slick on the foreshore and carried into the
underlying sediments or returned to the active surf zone by wave action. Since this process
has not been parameterized in the literature, COZOIL uses the hypothesis that the
governing variables are wave-breaking velocity V,,, exposed oil surface area A, oil
viscosity mand density r , and turbulent diffusivity in the surf zone D,. Then the mass-
transfer coefficient will be a function of the dimensionless groups:

3-20



rv.L

R =—2
¢ m
Sc:i

rD

where R, and S; are the Reynolds and Schmidt numbers, respectively. The characteristic
length L is taken as the square root of the exposed area A. The velocity of water falling
from the crest of a breaking wave of height H, onto the beach is:

Vb = 29 Hb

if frictional losses are neglected. The associated turbulent diffusivity is:

v

D:H_bz
T

where T is the wave period (Harris et al., 1962). Based on an empirical relationship
(Thibodeaux, 1977, 1979), the mass transfer coefficient for relatively insoluble high density
(r > 1) substances can be approximated by:

.08 ..0.33
&V,Lo eem o D,

h=0. : :
0368 m o grvaa L
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This equation is an empirical relationship developed for relatively low Reynolds number
flows on river bottoms. Surf zone Reynolds numbers are considerably higher, such that this
formulation appears to give unreasonably high removal rates. The rate coefficient, 0.36,
was therefore replaced by 0.0001 in COZOIL based on observed oil removal rates
(Gundlach, 1987). The actual mass removal rate is then:

d_m:rhA
dt

The mass removed from the oil on the foreshore surface by wave overwash is not all
carried into the groundwater. Some fraction is carried back into the surf zone with the
retreating wave. Lacking empirical values for these partitioning coefficients, the model
database supplies a set of default values based on Reed et al. (1988) (Table 3.3) and
allows the user to alter them (in the shoreline characteristics file) if desired.

Table 3.3. Default values for partitioning of oil removed from the beach face by the action
of waves. The oil removed is partitioned among the beach groundwater and
the surf zone surface in the given proportions.

Shore Type
1 2 3 4 5 6 7
Exposed Eroding | Sandy | Gravel | Tidal
Rock Cobble | Peat Beach | Beach | Flat Marsh
Scarp
Groundwater | 0.00 0.05 0.05 0.05 0.05 0.01 |0.01
Surface 1.00 0.95 0.95 0.95 0.95 0.99 10.99

3.3.6 Removal from the Sediment/Groundwater System

Oil which has penetrated the surface sediments and remains above the mean water table
(Figure 3.8) may be removed to the surf zone if the beach is subject to erosion by the
present wave field. A basic assumption here is that the presence of the oil will not
appreciably alter erodability of the beach sediments. Following Sunamura and Horikawa
(1974), COZOIL incorporates a dimensionless erosion/accretion parameter G,:

5
gtl+ tanr %%
2
G, =—2°

o T T o067

&DSOO
§L. o
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where

Ho - deep-water wave height (m)

L, - deep-water wave length (m)

r - offshore bottom slope

Dso - size of 50" percentile of sediment sample (m).

Beach erosion is assumed to occur for G, >18, accretion for G, < 4, and equilibrium in
between. [Note that CERC (1984) introduces some errors relative to the original document
in reporting these limiting values.]

3.3.7 Evaporation

Oil deposited on the foreshore or backshore is evaporated using the evaporative exposure
model of Stiver and Mackay (1984) as described in Section 3.2.2. The surface area of the
oil exposed for evaporation is defined by the area of the beach face oiled instead of by the
radius of the surface spillet.

3.3.8 Reflotation

Oil on the beach face (foreshore surface) or on the backshore which has not penetrated the
sediments may be refloated on a rising tide. As oil is refloated from the foreshore surface,
it is combined with an existing spillet if one is present at that coastal location. In this case,
the characteristics of the spillet become the mass-weighted characteristics of the spillet
plus the newly refloated oil. If a spillet does not exist at the coastal cell where reflotation is
occurring, a new spillet may be formed.
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